cunrren 11

Accessing Data from the Web Interface

This chapter provides information about accessing Cisco Mobile Wireless Transport Manager (MWTM)
data from the MWTM web interface by using a web browser.

This chapter contains:
e Supported Browsers, page 11-1
e Accessing the MWTM Web Interface, page 11-2
e Overview of the MWTM Web Interface, page 11-3
e Displaying the Home Page, page 11-12
¢ Downloading the MWTM Client from the Web, page 11-15
e Displaying Alarms and Events, page 11-19
e Displaying Summary Lists, page 11-20
e Displaying Status and Summary Reports, page 11-20
e Viewing Report Status, page 11-21
e Viewing Historical Statistics Report Settings, page 11-23
e Tools, page 11-25
e Understanding Groups, page 11-29
e Viewing Statistics, page 11-34

Supported Browsers

The MWTM web interface is supported on the following browsers:
e Microsoft Internet Explorer version 6.0 and 7.0 on Microsoft Windows operating system
e Mozilla Firefox 2.0 on Solaris 9 and Red Hat Linux Enterprise AS 4.0 operating system
e Mozilla Firefox 3.5+ on Solaris 10 and Red Hat Linux Enterprise 5.3 and Microsoft Windows
operating systems.

~

Note  The first time you attempt to connect to the MWTM server using Firefox 3.0, you must add an
exception to allow the connection. See Importing an SSL Certificate to an MWTM Client,
page 2-25 for more information.
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Bl Accessing the MWTM Web Interface

Checking Your Browser

To check your browser and screen settings, from the MWTM web interface Home page, select Browser
Checker.

~

Note  Opening the MWTM in an unsupported browser generates a warning. Also, if JavaScript is not enabled,
the MWTM web interface cannot function.

The Browser Checker window contains:

Pane or Field Description

Browser Information

Browser The name and version of the browser you are using.

Browser User Agent |Text string sent to identify the user agent to the server. Typically includes information such as the
application name, version, host operating system, and language.

Platform The platform type. For example, Win32.

Cookies Enabled Whether you have cookies enabled on the browser (Yes or No).

Javascript Enabled  |Whether Javascript is enabled (Yes or No).

AJAX Component The Asynchronous JavaScript and XML (AJAX) component sends asynchronous HTTP update
requests. The MWTM web application is only accessible to web browsers that have an AJAX
component enabled. Typical values include XMLHttpRequest (for Mozilla-based browsers) and
MSXML2.XmlHttp (for IE 6).

Screen Information

Size Resolution of the display; for example, 1600 x 1200.

Color Depth Depth of the color display; for example, 16.

Accessing the MWTM Web Interface

The home page of the MWTM web interface is the first window to appear when you launch the MWTM
web interface.

To access the MWTM web interface, use one of these methods:
e Open a browser and enter http://mwtm_server:1774 in the Address field. (1774 is the default port).
>

Note  Accessing the MWTM web interface through a URL other than http://mwtm-server:1774 is not
supported.

e From the MWTM client interface, choose View > MWTM Web Links > Home.

The MWTM Home page window opens in the browser window. For details about the Home page, see
Displaying the Home Page, page 11-12.
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Overview of the MWTM Web Interface

The MWTM web interface shows basic information about the events and objects that the MWTM
manages. The MWTM web interface shows:

Pane Description
Title Bar Shows:

e Mobile Wireless Transport Manager, version, and server name

e Managed networks (can be any combination of IP-RAN, ITP, CSG1, CSG2, GGSN, BWG, HA,
PDNGW, SGW, PCRF, and PDSN)

e Logout (appears only if you enable user access; see Configuring User Access, page 2-1)
e Help—Click this link to access context-sensitive online help

e Preferences—Click this link to access preferences that you can change from the web interface (see
Changing Web Preference Settings, page 4-18)

Location bar Shows where you currently are in the MWTM navigation tree.

Navigation Tree In the left pane, shows a tree of information organized by categories (see MWTM Web Interface
Navigation Tree, page 11-3).

Content Area In the right pane, shows detailed information about the object chosen in the navigation tree (see MWTM
Web Interface Content Area, page 11-5).

MWTM Web Interface Navigation Tree

You can easily navigate the features of the MWTM web interface by using the navigation tree in the left
pane. By default, the navigation tree is sorted by alarm severity, with objects having the most severe
alarms appearing at the top of the tree.

Note  To learn more about alarm severity, see Chapter 9, “Managing Alarms and Events.”

To view detailed information about a selection in the navigation tree, click the item in the tree. The
content area in the right pane shows details about the chosen item. A plus (+) or minus (-) just to the left
of the item indicates whether the item has subtending items under its domain.

The MWTM automatically updates the navigation tree when changes occur to discovered nodes or to the
network. When any changes occur in the MWTM client navigation tree, the MWTM web interface
reflects these changes in its navigation tree. For example, if you delete a node in the MWTM client, the
MWTM web interface removes that node from its navigation tree.

Note  For information about the navigation tree in the MWTM client interface, see MWTM Client Navigation
Tree, page 3-16.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
[ oL-23900-01 .m



Chapter 11 Accessing Data from the Web Interface |

W Overview of the MWTM Web Interface

The MWTM web interface navigation tree contains:

GUI Element Description
- Sorts all content in the navigation tree alphabetically by name.
b
z

Sort tree by name

P Sorts all content in the navigation tree by status, from the highest alarms to the lowest.
+
L

Sort tree by status

Home Shows links to MWTM client software, Cisco documentation, and information about the MWTM on the
Cisco web (see Displaying the Home Page, page 11-12).

Administrative The Administrative page of the MWTM web interface provides the following tabs:

General—Shows MWTM system information including messages, logs, status, and properties. See
Viewing General Tab Details, page 12-2.

SNMP—Provides access to SNMP (Simple Network Management Protocol) Editor to edit the SNMP
settings. See Viewing SNMP Tab Details, page 12-19.

Credentials—Provides access to Device Credentials Editor to edit the credential details for the nodes.
Viewing Credentials Tab Details, page 12-21.

Discovery—Allows you to discover the network. Viewing Discovery Tab Details, page 12-24.

User Management—Displays all users in the system along with the time of their most recent login, their
access level, and their account status. Viewing User Management Tab Details, page 12-29.

If MWTM User-Based Access is enabled, only users with authentication level 3 (Network Operator) and
higher can see all options. Users of all other levels see only the System Information and System Status

panes.
Active Alarms Shows alarms (see Displaying Alarms and Events, page 11-19).
Event History Shows information about the events delivered by the MWTM event logger and event processor for events

that the MWTM event logger and event processor deliver for all objects in the current network view (see
Displaying Alarms and Events, page 11-19).

Summary Lists Shows summaries of all objects that the MWTM manages (see Displaying Summary Lists, page 11-20).

Reports Common Statistics—Shows common statistic reports for AAA, CPU, IP Local Pool, Interface, and
Memory. For more information, see Viewing Common Statistics Reports, page 13-10.

ITP Statistics—Shows ITP statistic reports for AS, ASP, GTT Rates, Link, Link-Multi-Day, Linkset,
MLR, MSU Rates, and SCTP. For more information, see Viewing ITP Statistics Reports, page 13-45.

Mobile Statistics—Shows mobile statistic reports for CSG, GGSN, PDNGW, PDSN, and SGW. For
more information, see Viewing Mobile Statistics Reports, page 13-100.

RAN Statistics—shows RAN statistic reports for PWE3, QOS, and RAN-Optimized. For more
information, see RAN-Optimized Reports, page 13-198.

ITP Accounting—Shows ITP accounting reports for AS, GTT, and MTP3. For more information, see
Viewing ITP Accounting Reports, page 13-212.

Mobile Subscribers—Shows subscriber account reports for BWG, CSG, GGSN, HA, PDNGW, PDSN,
and SGW. For more information, see Viewing Mobile Subscribers Reports, page 13-215.
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GUI Element

Description

File Archive

Events—Shows archived events. For more information, see Viewing Archived Event Files on the Web,
page 9-24.

Inventory—Shows archived inventory reports. For more information, see Viewing File Archive
Inventory Reports, page 13-232

Common Statistics—Shows archived common statistic reports. For more information, see Viewing File
Archive Common Statistics Reports, page 13-234.

ITP Statistics—Shows archived ITP statistic reports. For more information, see Viewing File Archive
ITP Statistics Reports, page 13-240.

Mobile Statistics—Shows archived Mobile statistic reports. For more information, see Viewing File
Archive Mobile Statistics Reports, page 13-254.

RAN Statistics—Shows archived RAN statistic reports. For more information, see Viewing File Archive
RAN Statistics Reports, page 13-266.

ITP Accounting—Shows archived ITP accounting reports. For more information, see Viewing File
Archive ITP Accounting Reports, page 13-271.

Mobile Subscribers—Shows archived mobile subscribers reports. For more information, see Viewing
File Archive Mobile Subscribers Reports, page 13-272.

Tools Provides tools for launching CiscoView, CiscoWorks LMS Portal, and Device Center. Provides a search
tool for Home Agent and APN subscribers and Events and Alarms tool (see Tools, page 11-25).

Groups Displays user-defined groups (see Understanding Groups, page 11-29).

DEFAULT View Shows a current list of nodes in the DEFAULT view.

MWTM Web Interface Content Area

The content area of the MWTM client interface is fully described in MWTM Client Content Area,
page 3-17. That description also applies to the web interface. Additional navigational features that
appear only in the web interface include:

e Customizing Date and Time Ranges, page 11-5

e Using the Toolbar, page 11-6

Customizing Date and Time Ranges

Step 1

Step 2

Some windows require that you select date ranges for generating historical graphs and for synchronizing
alarms. The Customize the date and time range tool @ allows you to choose the dates with server
timezone.

To customize the date range:

Click the Customize the date and time range tool 54| in the toolbar of the content area. The Choose
a Date Range server timezone dialog box appears.

Enter:

a. Begin Date and End Date; or, select those dates by clicking the Calendar tool . These dates are
the dates with server timezone.

b. Begin Hour and End Hour from the drop-down menus, if they are available.

[ oL-23900-01
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~

Note The dialog box shows an error if the End Date is equal to or less than the Begin Date. Correct
the error before proceeding.

Step3  Click OK to accept the date and time changes; or, Cancel to cancel this operation.

The MWTM web interface accepts and applies the changes either by generating a report for the chosen
server time (in case of reports) or by synchronizing the alarms (in case of alarm synchronization).

Using the Toolbar

Depending upon the object you select in the navigation tree, the web interface toolbar provides these
tools and options:

Tool or Function |Description

Last Updated Date and time the MWTM last updated the information on the page.

Page Shows where you are (page X of X total pages) and lists the total number of entries.

@, Refresh Forces a refresh of the current web page. Click this icon to refresh the current page.

Status Refresh | Allows you change the default refresh interval of 180 seconds. Enter a value between 180 and 900 seconds.

Interval Note Changes you make are temporary to the current page. Navigating away from the page sets the status

refresh interval back to the default setting. To change the default setting, see Changing Web
Preference Settings, page 4-18.

Page Size Drop-down list of different page sizes (the number of table rows in the display). Click the drop-down arrow
to select a different value. The value that you select becomes the default page size for all pages in the web
interface.

The title bar displays the current page and total number of table entries.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Tool or Function

Description

Quick Search

Text box to filter the objects listed under the Summary List tables (Except for IP Addresses and Point Code
tables). Enter the string in the text box to filter the table by and then press Enter. The rows under the table
are filtered based on the string entered.

Below are the details for each Summary table about which columns are used for looking for the filtered
string:

e Alarms: Internal ID, Node, Feature

e Nodes: Internal ID, Display Name, Primary SNMP Address, Node Type, Feature, Software Version,
Serial Number, Reboot Reason, Status Reason

e Signaling Points: Internal ID, Name, Node, Network Name, Point Code, Variant, Network Indicator,
Status Reason

e Linksets: Internal ID, Name, Node, Signaling Point, Local Point Code, Adjacent Point Code, Linkset
Type, Status Reason

e Links: Internal ID, Node, Signaling Point, Linkset, Type, Status Reason

e Application Servers: Internal ID, Name, Node, Signaling Point, Protocol, Routing Key, Traffic Mode,
Status Reason

e Application Server Processes: Internal ID, Name, Node, Local IP Address, Status Reason

e Application Server Process Associations: Internal ID, Name, Node, Signaling Point, Application
Server, Protocol, Congestion Level, Status Reason

¢ Signaling Gateway Mated Pairs: Internal ID, Name, Mate, Node, Congestion Level, Status Reason
e Interfaces: Internal ID, Name, Node, Interface Type, Status Reason

e (Cards: Internal ID, Name, Node, Card Type, Model Name, Description, Status Reason, Hardware
Version, Firmware Version, Software Version

¢ RAN Backhauls: Internal ID, Name, Node, Location, Peer Name, Peer Node, Type, Status Reason

e RAN Shorthauls: Internal ID, Name, Node, Type, Location, Peer Name, Peer Node, Interface Type,
Status Reason

e PWE3 Backhauls: Internal ID, Name, Node, Peer Name, Peer Node, Status Reason

e PWES3 Virtual Circuits: Internal ID, Name, Node, Peer Name, Peer Node, Type, PSN Type, Remote
Interface String, Description, Status Reason

e Access Point Names: Internal ID, Name, Status Reason

e Software Versions: Name, Node Type, Software Version, Software Description

> Advances the display to the next page of information.

>> Advances the display to the last page of information.

< Advances the display to the previous page of information.

<< Advances the display to the first page of information.

B, Modify Opens the Event Filter dialog box. You can create a filter to display only the events in which you are

event filter

interested (see Setting Alarm or Event Filters, page 9-12).

Remove
T

Applies or removes a filter that you created.
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Tool or Function

Description

Archived

Link that shows only archived alarms or events. This link appears when you select Event History or Active
Alarms in the navigation tree. It also appears when you click the Alarms tab or Recent Events tab for a
specific object.

A

CautionIn the Serverproperties file, you can limit the number of rows in the archived events table with the
MAX_ARCHIVED_EVENT
_DB_ROWS property. The default value is 200,000. Increasing this value can have severe
impact on server performance and can cause the server to run out of memory.

Customize the
date and time
range

Opens the Choose a Date Range Server timezone dialog box (see Customizing Date and Time Ranges,
page 11-5).

g
Graph Series
Editor

Opens the Graph Series Editor dialog box, which provides a check box for each available data series. Check
the check box to display a series, and uncheck the check box to hide a series.

If you click OK without selecting a series, it is the same as clicking Cancel.

By default, the MWTM displays no more than 12 series by default. To change this default setting, see
Display Series Dialog Box, page 7-113.

Run

4

Runs the report type for the chosen duration.

2

Exports the data in the table to comma-separated value file (CSV file). You can save this file to disk or open
it with an application that you choose (for example, Microsoft Excel).

Export the

report as a CSV

file

Data Range Label that shows the chosen time range for the historical statistics. The label displays the data range with

(timezone) server time.

Type Drop-down list of report types.

Duration Drop-down list of default time ranges. Select one of these options, then click the Run tool. To specify a
nondefault time range, click the Customize Date and Time Range too.

Output Drop-down menu that provides these options:

e Graph—Displays statistical data in graphs and tables
e Table—Presents statistical data in tabular format only

e CSV—Exports statistical data using comma-separated values

Sort Parameter

Used in the graph output of certain reports to select the criteria for including a top set of series and for
ordering the corresponding graphs displayed.

Pause
im"

Pauses the page refresh feature. Click Pause to disable the page refresh that would normally occur after the
Status Refresh Interval. Click Pause again to re-enable the Status Refresh Interval.

D Edit Notes

Enables you to edit or add notes for events.
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Tool or Function

Description

Slow Poller
Interval

Allows you to change the default slow poller interval of 60 seconds. Enter a value between 60 and 300
seconds.

Note Changes you make are temporary to the current page. Navigating away from the page sets the status
refresh interval back to the default setting. To change the default setting, see Changing Web

Preference Settings, page 4-18.

Fast Poller
Interval

Allows you to change the default fast poller interval of 15 seconds. Enter a value between 5 and 60 seconds.

Note Changes you make are temporary to the current page. Navigating away from the page sets the status
refresh interval back to the default setting. To change the default setting, see Changing Web

Preference Settings, page 4-18.

Reset Counters

Enables you to modify the counter reset settings to one of the following:
e Show counters since reboot
e Show counters since last poll

e Show counters since user reset

Launch

Drop-down list of applications you can launch:
¢ CiscoView (This option is available only for non SAMI nodes and is not displayed for PCRF nodes)
¢ CiscoWorks LMS Portal
e Device Center (This option is not displayed for PCRF nodes)
¢ Node Home Page (This option is displayed based on the CiscoWorks user configuration)

After you choose the application, click the F Run icon to launch it.

Severity

Drop-down list of the severities of alarms or events. Severity can be Critical, Major, Minor, Warning,
Informational, Indeterminate, or Normal.

This drop-down list appears when you select Event History or Active Alarms in the navigation tree. It also
appears when you click the Alarms tab or Recent Events tab for a specific object.

Change
Severity

Button to change the severity level of an alarm or event.

To change the severity level, select one or more alarms or events by clicking the corresponding check
boxes, choose a severity from the Severity drop-down list, then click Change Severity.

This button appears when you select Event History or Active Alarms in the navigation tree. It also appears
when you click the Alarms tab or Recent Events tab for a specific object.

Clear Selection

Link to clear the selection of one or more events or alarms. To select one or more alarms or events, check
the corresponding check boxes. To clear the selection, click the Clear Selection link.

This button appears when you select Event History or Active Alarms in the navigation tree. It also appears
when you click the Alarms tab or Recent Events tab for a specific object.

Toolbar for The web interface provides the same toolbar for alarms and events as the client interface. For full
alarms and descriptions of these tools, see Toolbar Buttons, page 9-8.
events
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Tool or Function

Description

Actions

Drop-down menu appears when you hover over the Actions button. The Actions button is displayed for all
the object based Summary Lists (i.e. except Node Distributions, Alarms, Software Versions, IP Addresses,
and Point Code), Management interfaces and Physical folders of the nodes under the navigation tree, and
under the Details tab of all the objects.

Note  Users with authentication level 1 cannot see the Actions button. Also, the Manage and Ignore
options have separate permissions for Manage/Unmanage and Ignore/Unignore. The menu item is
not shown if both the permissions are invalid.

Note The Action Menu appears in the Shorthauls tab for Backhauls and in the Nodes tab for APNs.

For all the objects/summary lists except APN the drop-down menu contains:

¢ Normal Poll Node—Polls the chosen nodes.

Clean Poll Node—Polls all chosen nodes and removes any Unknown objects after the completion of
the poll.

e Provision—Allows you to provision the objects.

Edit Properties—Opens the MWTM: Edit Properties Dialog window.
Edit SNMP IP Addresses—Opens the MWTM: Edit SNMP IP Addresses Dialog window.

Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.

Manage/Unmanage—Labels the chosen node Managed or Unmanaged. The option Manage or
Unmanage is displayed based on the selected item.

Allow Trap Processing/Disallow Trap Processing—Enables or disables the MWTM to process traps
from the chosen node. The option Allow Trap Processing or Disallow Trap Processing is displayed
based on the selected item.

Allow Report Polling/Disallow Report Polling—Enables or disables the report polling. The option
Allow Report Polling or Disallow Report Polling is displayed based on the selected item. This option
is not displayed for RAN-O and ONS nodes.

e Delete—Deletes the chosen object.
For Management interfaces and Physical folders of the nodes, the drop-down menu contains:
e Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.
For APNSs the drop-down menu contains the following options:

e Search for APN Subscriber—Used to search for a specific subscriber across one or more designated
GGSN, PDNGW, and SGW subscribers. See Searching for APN Subscribers, page 11-28 for more
information.

e Ignore/Unignore—Ignores or stops ignoring the chosen object at the next polling cycle.

e Delete—Deletes the chosen object.

Note For the nodes that are not manageable, the Actions menu contains only Ignore and Delete options.

The Details tab of the groups created contains the Actions drop-down menu which contains the following
options:

e Batch Provision—Used to perform Batch Provisioning. See Batch Provisioning, page 11-32.

Note The Actions button does not appear for the groups if they do not have a batch file of the
corresponding node type.
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MWTM: Edit Properties Dialog

The Edit Properties option is available under the Actions menu on the Details tab of all the nodes and on
the Details tab of ITP node signaling points. This options opens MWTM: Edit Properties Dialog window
that has editable properties.

Node properties include Name and Interface Structure. For the editable signaling point properties, only
the Name is editable.

The MWTM: Edit Properties Dialog window contains:

Field or Button

Description

Name Name of the node. The name field is green for valid input and is red for invalid input. The name may include
up to 100 alphanumeric and the special characters hyphen (-), underscore (_), period (.), and colon (:). The
Save option is disabled for the invalid name. After saving, this new name gets displayed in the navigation
tree and in the Details panel.
Note  The character .’ is allowed only when the resulting name is a valid hostname.
Interface Drop-down menu to configure the way the MWTM displays the physical interfaces of a node (excluding the
Structure ONS node). Choices include:
e Default—Restores the interface structure to the default setting for the node. For example, if the default
structure is hierarchical, choosing this option restores the parent-child hierarchy in the Physical folder.
Note In cases where the MWTM cannot determine the interface hierarchy of a node, the MWTM sets its
default structure to be flat (that is, all interfaces appear at the same level).
e Force Flat—Forces the interface structure of a node to be flat (that is, no hierarchy). All interfaces in
the Physical folder appear at the same level.
Force Hierarchical—Forces the interface structure of a node to be hierarchical (that is, to display
parent-child relationships among interfaces).
Save Saves the changes you have made.
Restore Restores the changes that you make to the fields of the Edit Properties dialog box and leaves the dialog box
open.
Cancel Closes the window without saving the changes you have made.
Help Displays online help for this window.

MWTM: Edit SNMP IP Addresses Dialog

The Edit SNMP IP Addresses option is available under the Actions menu on the Details tab of all the
nodes. This options opens MWTM: Edit SNMP IP Addresses Dialog window that has editable
properties.

The Edit SNMP IP Addresses option is available only for the users with authentication level 4 and level
5.
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The MWTM: Edit SNMP IP Addresses Dialog window contains:

Field or Button

Description

Available IP

List of all IP addresses associated with this node that users could not or do not want the MWTM to use for

Addresses SNMP polling.

IP Addresses Lists the IP addresses associated with the node, including the primary SNMP address and all backup IP

for SNMP addresses, that are intended for SNMP.

Add Adds the IP Addresses from the Available IP Address box to the IP Addresses for SNMP box. This option
is disabled if there is no IP address in the Available IP Address box.

Remove Removes the IP Addresses from the IP Addresses for SNMP box and adds to the Available IP Addresses
box. This option is disabled if there is no IP address in the IP Addresses for SNMP box.

Raise Moves the selected IP address one level up in the IP Addresses for SNMP box. This option is disabled if
there is only one IP address in the IP Addresses for SNMP box.

Lower Lowers the selected IP address one level below in the IP Addresses for SNMP box. This option is disabled
if there is only one IP address in the IP Addresses for SNMP box.

Save Saves the changes you have made.

Cancel Closes the window without applying any changes you have made.

Help Displays online help for this window.

Displaying the Home Page

The MWTM web interface Home page provides access to MWTM client software, Cisco documentation,

and information about the MWTM.

To access the Home page of the MWTM web interface, click Home under the navigation tree in the left

pane.
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The content area in the right pane shows these GUI elements:

Pane

GUI Element

Description

Client Software

Download Windows Client
Download Solaris Client
Download Linux Client

Browser Checker

Shows the download instructions for the:

¢ Windows client

e Solaris client

e Linux client

e Information about the browser and screen display

For details, see Downloading the MWTM Client from the Web,

page 11-15.
MWTM on MWTM Home Page Shows hyperlinks to:
Cisco.com MWTM Software Download e MWTM information on the Cisco website
Page ¢ MWTM software download from Cisco.com
Latest MWT,M e Most recent versions of MWTM documentation
Documentation
Engineering Software Updates e Software updates provided by Cisco Engineering
(FTP) e Supported IOS Releases document for the current release
MWTM Supported 10S For details, see Accessing Software Updates and Additional Information,
Releases page 11-17.
User README Shows:
Documentation | cyANGES e README.uxt file
Help Home Page e Major new changes for the release
Frequently Asked Questions ¢ Online Help system for the MWTM
Release Notes e HTML version of the FAQs
Install Guide e PDF versions! of the:
User Guide — Release Notes for the Cisco Mobile Wireless Transport Manager
OSS Integration Guide — Installation Guide for the Cisco Mobile Wireless Transport
Alarm Guide Manager
Third Party and Open Source — User Guide for the Cisco Mobile Wireless Transport Manager
Copyrights — 0SS Integration Guide for the Cisco Mobile Wireless Transport
Manager
— Alarm Guide for the Cisco Mobile Wireless Transport Manager
— Third Party and Open Source Copyrights
For details, see Viewing the MWTM Technical Documentation,
page 11-17.
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Pane GUI Element

Description

System MWTM Server Help
Documentation |Command

Large Deployment Tuning
README (pdf)

Bandwidth Usage README
Export Reports README

MWTM Supported SNMP
MIBs

Shows:

CLI output of the mwtm help command

Document on MWTM Tuning for Large IP-RAN deployment
README-Bandwidth-Usage.txt file
README-ExportReports.txt file

Lists of MIBs, which may include:

(IPRAN only)
RAN MIBs

(ITP only)
ITP MIBs

(mSEF only)
CSG1 MIBs

(mSEF only)
CSG2 MIBs

(mSEF only)
GGSN MIBs

(mSEF only)
BWG MIBs

(mSEF only)
HA MIBs

(PDNGW only)
PDNGW MIBs
(SGW only)
SGW MIBs
(PDSN only)
PDSN MIBs
(PCRF only)
PCRF MIBs
Common MIBs

For details, see MIB Reference, page F-1.
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Pane GUI Element Description

Managed e (ITP only) ITP OS e MWTM-OS-Info-ITP file

PDljct;iorggmanon README o MWTM-OS-Info-IPRAN file
. gg 12111311\\7/1 OE”ly) IP-RANOS | oy WIM-0S-Info-CSG1 file

e MWTM-OS-Info-CSG2 file
(mSEF, CSG1 only) .
Content Service Gateway | * MWIM-OS-Info-GGSN file
1 (CSG1) OSREADME | o  \fWTM-OS-Info-HA file

(mSEF, CSG2 only) o MWTM-OS-Info-BWG file
Content Service Gateway .

(mSEF, GGSN only) e MWTM-OS-Info-PDNGW file
Gateway GPRS Service | « MWTM-0S-Info-SGW file

Node (GGSN) OS . '
README MWTM-OS-Info-PCRF file
(mSEF, HA only)
Home Agent (HA) OS
README

(mSEF, BWG only)
Broadband Wireless
Gateway (BWG) OS
README

(mSEF, PDSN only)

For details, see Viewing Managed Platform Documentation, page 11-17.

Packet data Serving Node
(PDSN) OS README

(mSEF, PDNGW only)

Packet Data Network
Gateway (PDNGW) OS
README

(mSEF, SGW only)

Serving Gateway (SGW)
OS README

(mSEF, PCRF only)

Policy and Charging
Rules Function (PCRF)
OS README

1. To access the latest versions, go to the parent index for Cisco MWTM user documents:
http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html

Downloading the MWTM Client from the Web

You can access the MWTM client installation software for Linux (unsupported), Solaris, and Windows
from the MWTM web interface Home page. This access is useful if you do not have the CD-ROM, or if
you prefer to download the software by using your web browser. Once you have downloaded the MWTM
client installation software to your workstation, you must install the software on your local system.

[ oL-23900-01
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For more information about installing the MWTM client software by using a web server, see the
following chapters in the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.5:

e “Installing the MWTM on Solaris”
e “Installing the MWTM on Windows”
e “Installing the MWTM on Linux”

Related Topics
e Downloading the Solaris Client, page 11-16

¢ Downloading the Windows Client, page 11-16
e Downloading the Linux Client (Unsupported), page 11-16

Downloading the Solaris Client

To access the MWTM Client for Solaris page, select Download Solaris Client.

The web interface shows the supported Solaris versions and instructions for downloading the Solaris
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 for a detailed
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then
enter the mwtm client command from the command line.

Downloading the Windows Client

To access the MWTM Client for Windows page, select Download Windows Client.

The web interface shows supported Windows versions and instructions for downloading the Windows
setup program. After downloading the setup program onto your desktop or other Windows directory,

double-click the setup.exe icon to start the setup program and launch the installation wizard. See the
Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 for detailed procedures.

To start the client after installation, launch it from the Windows Start menu or double-click the MWTM
Client icon on your desktop.

Downloading the Linux Client (Unsupported)

To access the MWTM Client for Linux page, select Download Linux Client.

>
Note The MWTM does not support the MWTM client for Linux. Use the MWTM Linux client under
advisement.

The web interface shows the supported Linux versions and instructions for downloading the Linux
client. See the Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 for a detailed
procedure.

To start the client after installation, add the /opt/CSCOsgmClient/bin subdirectory to your path, then
enter the mwtm client command from the command line.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Downloading the MWTM Client from the Web 1l

Accessing Software Updates and Additional Information

You can access this information about the MWTM from the MWTM web interface Home page. To:

e View information about the MWTM or any other Cisco product available on Cisco.com, select Cisco
Home Page.

e Read Cisco literature associated with the MWTM, including product data sheets, Q and As, and
helpful presentations, select MWTM Home Page.

¢ Access software updates for the MWTM from Cisco.com for FTP, select Engineering Software
Updates (FTP). The Cisco Systems Engineering FTP server page appears.

e Access software updates for the MWTM from Cisco.com, select MWTM Software Download
Page. The Software Download page for the MWTM appears.

e Access the most recent versions of customer documentation for the MWTM, select Latest MWTM
Documentation. The Cisco Mobile Wireless Transport Manager documentation page on Cisco.com
appears. From this page, you can view the latest versions of MWTM release notes, installation
guides, and end-user guides.

S,

Note If you cannot access Cisco.com from your location, you can always view the customer
documentation that was delivered with the MWTM software. See the Viewing the MWTM
Technical Documentation, page 11-17.

Viewing the MWTM Technical Documentation

From the MWTM web interface Home page, you can view this MWTM technical documentation. To
view the:

¢ Entire Cisco Mobile Wireless Transport Manager Help System, select Help Home Page.

e Entire User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 as a PDF file on the web,
using the Adobe Acrobat Reader, select User Guide (PDF).

e Entire Installation Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 as a PDF file on
the web, using the Adobe Acrobat Reader, select Install Guide (PDF).

e Entire Release Notes for the Cisco Mobile Wireless Transport Manager 6.1.5 as a PDF file on the
web, using the Adobe Acrobat Reader, select Release Notes (PDF).

¢ Frequently Asked Questions (FAQs) about the MWTM, select Frequently Asked Questions.
e Syntax for every MWTM command, select MWTM Server Help Command.

A

Caution  These PDF versions of technical documents might not be the latest versions. For the latest versions, go
to: http://www.cisco.com/en/US/products/ps6472/tsd_products_support_series_home.html.

Viewing Managed Platform Documentation

Depending upon which type(s) of network you are managing, you can view the following MWTM
managed platform documentation from the MWTM web interface:

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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e (ITP only) ITP OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-ITP file. This file contains a list of the supported OS
software images for:

— ITP nodes
- GTT encoding scheme
— MLR address table configuration
— GTT accounting statistics reports
— Route table and GTT table deployment
— MSU rates
— ITP provisioning
To access the MWTM ITP OS README page, choose ITP OS README from the MWTM Home
page.
e (IPRAN only) IPRAN OS README—Shows the contents of the

/opt/CSCOsgm/instal/MWTM-OS-Info-IPRAN file. This file contains a list of the supported OS
software images for:

— MWR nodes
— ONS nodes
- RAN SVC cards

To access the MWTM IPRAN OS README page, choose IPRAN OS README from the MWTM
Home page.

e (mSEF, CSGI only) CSG1 OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-CSG file. This file contains a list of the supported OS
software images for CSGI.

To access the MWTM CSG1 OS README page, choose CSG1 OS README from the MWTM
Home page.

e (mSEF, CSG2 only) CSG2 OS README—Shows the contents of the
/opt/CSCOsgm/instal/MWTM-OS-Info-CSG?2 file. This file contains a list of the supported OS
software images for CSG2.

To access the MWTM CSG2 OS README page, choose CSG2 OS README from the MWTM
Home page.

e (mSEF, GGSN only) GGSN OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-GGSN file. This file contains a list of the supported OS
software images for GGSN.

To access the MWTM GGSN OS README page, choose GGSN OS README from the MWTM
Home page.

e (mSEF, HA only) HA OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-HA file. This file contains a list of the supported OS
software images for HA.

To access the MWTM HA OS README page, choose HA OS README from the MWTM Home
page.

e (mSEF, BWG only) BWG OS README—Shows the contents of the /opt/CSCOsgm/install/
MWTM-OS-Info-BWG file. This file contains a list of the supported OS software images for BWG.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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To access the MWTM BWG OS README page, choose BWG OS README from the MWTM
Home page.

(mSEF, PDSN only) PDSN OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-PDSN file. This file contains a list of the supported OS
software images for PDSN.

To access the MWTM PDSN OS README page, choose PDSN OS README from the MWTM
Home page.

(mSEF, PDSN only) PDNGW OS README—Shows the contents of the
/opt/CSCOsgm/instal/MWTM-OS-Info-PDNGW file. This file contains a list of the supported OS
software images for PDNGW.

To access the MWTM PDNGW OS README page, choose PDNGW OS README from the
MWTM Home page.

(mSEF, SGW only) SGW OS README—Shows the contents of the
/opt/CSCOsgm/instal/MWTM-OS-Info-SGW file. This file contains a list of the supported OS
software images for SGW.

To access the MWTM SGW OS README page, choose SGW OS README from the MWTM
Home page.

(mSEF, PCRF only) PCRF OS README—Shows the contents of the
/opt/CSCOsgm/install/MWTM-OS-Info-PCRF file. This file contains a list of the supported OS
software images for PCRF.

To access the MWTM PCRF OS README page, choose PCRF OS README from the MWTM
Home page.

Displaying Alarms and Events

To display alarms in the web interface, click Active Alarms in the navigation tree, or select an object in
the navigation tree and click the Alarms tab.

To display events in the web interface, click Event History in the navigation tree, or select an object in
the navigation tree and click the Recent Events tab.

Viewing alarms and events in the web interface is essentially the same as viewing them in the MWTM
client. Only minor differences exist:

A paging feature for paging through large tables.

A refresh interval that you can change.

An Archived link for viewing archived alarms.

Alarm selection by check box and a Clear Selection link.

Severity drop-down list and a Change Severity button.

For detailed descriptions of these tools, see the “Using the Toolbar” section on page 11-6.

For descriptions of the columns, see the “Right-click Menus” section on page 9-11.
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Displaying

Summary Lists

Displaying Summary Lists in the web interface is essentially the same as displaying them in the MWTM
client. Only minor differences exist. Clicking on an object under the Summary Lists in the web interface
causes the content area to show information about the object.

For details on:
e Navigating table columns, see Navigating Table Columns, page 4-23.
e The toolbar, see Using the Toolbar, page 11-6.

For complete information about Summary Lists, see the Displaying Object Windows, page 8-3.

Displaying Software Versions

Displaying

The Software Versions table lists the software versions for each node the MWTM manages.
To access the Software Versions page:
e From the Web interface navigation tree, choose Summary Lists > Nodes > Software Versions.
¢ From the MWTM main window, choose View > MWTM Web Links > Software Versions.
For details on:
e Navigating the columns of the Software Versions table, see Navigating Table Columns, page 4-23.
e The toolbar, see Using the Toolbar, page 11-6.

The Software Versions table contains:

Column Description

Name Name of the node.

This column is displayed by default.

Node Type Type of node.
This column is displayed by default.

Feature Name of the feature.

This column is displayed by default.

Software Version Software version used by the node.

This column is displayed by default.

Software Description |Full software version information.

This column is displayed by default.

Status and Summary Reports

You can view a table, graph, or CSV file that shows the overall state of the available MWTM reports, the
time the server took to gather data from the network and store it in the database, and enable or disable
reports from the report page. You can also run hourly and daily performance summary reports.
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Step 2

Step 3

Viewing Report Status 1l

In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears
as described in Viewing Report Status, page 11-21.

From the Type pulldown menu, select one of the following types of reports:
e Report Status—See Viewing Report Status, page 11-21.
e Performance Summary Hourly—See Performance Summary Hourly Report, page 11-22.
e Performance Summary Daily—See Performance Summary Daily Report, page 11-22.

Select a duration and output type. See the “Using the Toolbar” section on page 11-6 for more information
about these fields.

Viewing Report Status

Step 1

Step 2

The Reports page in the MWTM web interface allows you to view a table, graph, or CSV file that shows
the overall state of the available MWTM reports. You can also enable or disable reports from the report

page.

Only reports that run on a regularly scheduled interval are displayed in the Hourly and Daily data.
Reports that run continuously are not displayed.

Only reports that run on a regular scheduled interval display information in the following columns:Last
Start Time, Last End Time, and Duration. Reports that run continuously display N/A for these columns.
A report that has not yet run has Unknown in the above columns.

To access the main Reports page:

Do one of the following:

¢ In a web browser, launch the MWTM web interface (see Accessing the MWTM Web Interface,
page 11-2). In the navigation tree, click Reports.

e From the MWTM client, in the MWTM main window, choose View > MWTM Web Links >
Reports.

The Reports page in the content area shows the Report Type and the status (enabled or disabled). If you
have generated a report, a green status ball and the word “Enabled” appear in the Status column. If you
have not generated a report, a red status ball and the word “Disabled” appears.

~

Note  Clicking a Report Type takes you directly to the report data page.

The Status column indicates whether you have enabled or disabled data gathering for the specified report
type.

To enable a report in the MWTM Web interface, click “Disabled” in the Status column. The Status
changes “Enabled” and a green status ball appears.
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Performance Summary Hourly Report

Step 1

Step 2

The Performance Summary Hourly Report shows the time it takes to gather the data from the network
and store it in the database. This report shows data for reports that are invoked via an hourly cronjob only
and not reports that run continuously.

In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears
as described in Viewing Report Status, page 11-21.

From the Type pulldown menu, select Performance Summary Hourly.

GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using
the Toolbar, page 11-6.

Table If you select the Output Type Table, the table contains:

e Report Type—Type of report.

e Start Time (timezone)—Time the report started.

e End Time (timezone)—Time the report ended.

e Duration (secs)—Time it took to run the report.

e Object Count—Number of objects on which the report was run.

Note If the Output Type is Table or CSV, the same data is presented but
the column headings are labeled by data type.

Expand to Full Screen |If Output Type is Graph, this text link displays the graph in a new,
full-screen window for easier viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second.

Note If no data exists between any two data points, the graph displays a
color-coded vertical bar to show the period for which no data is
available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and
the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.

Performance Summary Daily Report

Step 1

Step 2

The Performance Summary Daily Report shows the time it takes to gather the data from the network and
store it in the database. This report shows data for reports that are invoked via a daily cronjob only and
not reports that run continuously.

In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears

as described in Viewing Report Status, page 11-21.

From the Type pulldown menu, select Performance Summary Daily.

for the Cisco Mobile Wireless Transport Manager 6.1.5
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GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using
the Toolbar, page 11-6.

Table If you select the Output Type Table, the table contains:

e Report Type—Type of report.

e Start Time (timezone)—Time the report started.

e End Time (timezone)—Time the report ended.

e Duration (secs)—Time it took to run the report

¢ Object Count—Number of objects on which the report was run.

e If the Output Type is Table or CSV, the same data is presented but the
column headings are labeled by data type.

Expand to Full Screen |If Output Type is Graph, this text link displays the graph in a new,
full-screen window for easier viewing.

Duration (Secs) If Output Type is Graph, Y-axis label that shows duration in second.

Note If no data exists between any two data points, the graph displays a
color-coded vertical bar to show the period for which no data is
available.

Time If Output Type is Graph, X-axis label that shows a historical time scale and
the server time zone.

Legend If Output Type is Graph, color-coded legend that shows labels for output.

Bits/Sec or Bytes/Sec |If Output Type is Graph, Y-axis label that shows traffic rate in bits per
second. The Y axis automatically scales to the interface speed.

Note If no data exists between any two data points, the graph displays a
color-coded vertical bar to show the period for which no data is
available.

Viewing Historical Statistics Report Settings

Step1  In the MWTM Web interface, in the navigation tree, click Reports. The Report Status window appears
as described in Viewing Report Status, page 11-21.

Step2  Click the Settings tab. The Historical Stats Report Settings information is displayed.
You can click on Disabled or Enabled to change the state of any of the reports.

You can click on any field, except for the Reports Directory field, to modify its value.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Field

Description

General Settings

Reports Directory

Specifies the directory in which the MWTM reports are stored. You
must use the CLI to change the directory in which the reports are
stored; you cannot click on this field to modify it.

Time Mode

Specifies the time mode, either 12-hour or 24-hour, for the reports.

Master Report Flag

If this option is enabled, the individual report settings are used. If this
is option is disabled, all reports are turned off.

Perform Disk Space
Checking

Specifies whether disk space checking is enabled or disabled.

Export Reports

Specifies whether to automatically generate reports in CSV format.

15 Min Stats Aging (Days)

Specifies the database aging value for 15-minute statistics. When
records exceed the specified value, they are aged out of the database.

Hourly Stats Aging (Days)

Specifies the database aging value for hourly statistics. When records
exceed the specified value, they are aged out of the database.

Daily Stats Aging (Days)

Specifies the database aging value for daily statistics. When records
exceed the specified value, they are aged out of the database.

Monthly Stats Aging (Days)

Specifies the database aging value for monthly statistics. When
records exceed the specified value, they are aged out of the database.

Custom Stats Aging (Days)

Specifies the database aging value for custom statistics. When
records exceed the specified value, they are aged out of the database.

15 Min CSV Aging (Days)

Specifies the database aging value for 15-minute CSV statistics.
When records exceed the specified value, they are aged out of the
database.

Hourly CSV Aging (Days)

Specifies the database aging value for hourly CSV statistics. When
records exceed the specified value, they are aged out of the database.

Daily CSV Aging (Days)

Specifies the database aging value for daily CSV statistics. When
records exceed the specified value, they are aged out of the database.

Monthly CSV Aging (Days)

Specifies the database aging value for monthly CSV statistics. When
records exceed the specified value, they are aged out of the database.

Inventory Aging (Days)

Specifies the database aging value for inventory statistics. When
records exceed the specified value, they are aged out of the database.

Node Name Type

Name type for the Node column of the CSV reports.

The valid values are:

DNS Name
Custom Name

Sys Name
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Tools W

Field Description

ITP Report Settings | Show links with no capacity |Specifies whether to show links/linksets that do not have planned
set (nullcaps) send and receive capacities.
Show SCTP IP Links Specifies whether to show SCTP IP links.
High In-Service Ratio Displays the high value for the In-Service ratio threshold.
Threshold
High Utilization Ratio Displays the high value for the utilization ratio threshold.
Threshold

Tools

To access launch and search tools, click Tools in the navigation tree of the MWTM web interface. The
following options are available:

e Launch Tools, page 11-25
e Events and Alarms, page 11-25
e Search Tools, page 11-27

Launch Tools

If you have integrated with a CiscoWorks server, one or more of the following applications appears in
the Launch pane as active links:

¢ CiscoView
e CiscoWorks LMS Portal
e Device Center

The name of the server appears in parentheses following the application names. To launch an application,
click the application name. See Integrating the MWTM with Other Products, page 4-36.

Events and Alarms

The Events and Alarms pane contains the following links:
¢ Client disconnect sound
e Alarm Synchronization

The Events and Alarms tool allows you to select a sound to be played when the client loses its connection
to the MWTM server. By default, no sound is played when the client loses its connection to the server.
You must select a sound to be played.

Step1  Click Tools in the navigation tree of the MWTM web interface. From the Client disconnect sound
pulldown menu, select a sound. The sound you selected is saved.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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W Tools

Step 2

Note

After selecting a client disconnect sound, click Play to sample the sound.

Make sure you are not logged into the MWTM client at the same time that you are changing the client
disconnect sound in the MWTM web interface. Any sound changes you make using the MWTM client
override changes you make using the web interface.

You can use the MWTM client interface to create and change event sound filters for the MWTM client
as explained in Setting Sounds for Events at an MWTM Client, page 9-38.

Alarm Synchronization

Toolbar Buttons

Click the Alarm Synchronization link to open the Alarm Synchronization page. This page contains the
following toolbar buttons and the panes:

e Toolbar Buttons, page 11-26

e Trap Target Information, page 11-26

e Match Alarms by Date Range, page 11-27

e Match Alarms by Alarm Id Range, page 11-27

The page contains the following toolbar buttons:

Field or Button Description

Back Use this button to return to the previous page.

F Click this icon to forward the alarms within the specified range.

Forward Alarms

Trap Target Information

The Trap Target Information pane contains the following fields:

Field or Button Description

Target Host Enter the destination host name or IP address in this text field.

Name or IP

Address

Target Port Host port number to which the MWTM should forward traps.

SNMP SNMP community string that the MWTM should include in forwarded traps.
Community

String
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m. 0L-23900-01 |



| Chapter11  Accessing Data from the Web Interface

Tools W
Field or Button Description
SNMP Version  |Trap version to forward. Valid values are 1 and 2c.
Trap Type Type of trap that the MWTM should forward to this host. Valid trap types are:

CISCO-SYSLOG: The CISCO-SYSLOG-MIB clogMessageGenerated trap.
CISCO-EPM: CISCO-EPM-NOTIFICATION-MIB ciscoEpmNotificationRev1
trap.

CISCO-EPM-2: CISCO-EPM-NOTIFICATION-MIB ciscoEpmNotificationRev2
trap.

Match Alarms by Date Range

The Match Alarms by Date Range pane contains the following fields:

Field or Button Description

@I Opens the Customize Date and Time Range dialog box (see Customizing Date and
Time Ranges, page 11-5).

Customize Date
and Time Range

Clear Click this icon to clear the alarm dates and enable match by ID section.

Start Alarm The start alarm change time to forward the traps.
Change Time

End Alarm The end alarm change time to forward the traps.
Change Time

Match Alarms by Alarm Id Range

The Match Alarms by Date Range pane contains the following fields:

Field or Button Description

Clear Click this icon to clear the alarm IDs and enable match by date section.

Start Alarm Id The start alarm ID to forward the traps.

End Alarm Id The end alarm ID to forward the traps.

Search Tools
~

Note You must have HA (for Home Agent subscriber tool) or GGSN, PDNGW, or SGW (for APN Subscriber
tool) networks enabled to use this tool (for details on enabling HA, see mwtm manage, page B-46).

The Search pane provides a tool that you use to search for a specific subscriber across one or more
designated Cisco Home Agent (HA) routers or to search for GGSN, PDNGW, and SGW subscribers.
These tools are useful for troubleshooting problems that subscribers might report.

In the Search pane, click one of the following options:

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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¢ Search for Home Agent Subscriber (See Searching for Home Agent Subscribers, page 11-28)
¢ Search for APN Subscriber (See Searching for APN Subscribers, page 11-28)

Searching for Home Agent Subscribers

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Step 8

Click Tools in the navigation tree of the MWTM web interface, then select Search for Home Agent
Subscriber.

Click the Identifier Type radio button:

e Network Access Identifier—Use this option if you know the subscriber’s network access identifier
(NAI); for example, jdoe @xyz.com.

e [P Address—Use this option if you know the subscriber’s IP address

Depending on your selection in Step 2, enter the subscriber’s NAI or IP address in the Mobile Node
Identifier field.

In the Select Groups to Search pane, click on the group(s) for which you want to search for Home
Agents. This field is only available if you have previously created an HA config, HA report, or General
group. (See Creating Groups, page 11-29).

In the Select Home Agents to Search pane, check the check boxes of the Home Agents that you want to
search. (The default setting is all Home Agents.) Click Select All to check all boxes and search all Home
Agents. Click Deselect All to clear all check boxes.

To conduct the search, click the Search button.
The Search Results popup window appears.

If the search successfully locates the subscriber, and you want to troubleshoot the problem, click the
Troubleshoot Subscriber button in the Search Results popup.

The MWTM automatically navigates to the Troubleshooting tab of the HA device.

For more information about troubleshooting devices by using the Troubleshooting tab, see Viewing
Troubleshoot, page 7-39.

Searching for APN Subscribers

Step 1
Step 2
Step 3

Step 4

Step 5

Click Tools in the navigation tree of the MWTM web interface, then click Search for APN Subscriber.

In the MSISDN field, enter the MSISDN for which you want to search.

In the Select Groups to Search pane, click on the group(s) for which you want to search for GGSN,
PDNGW, or SGW subscribers. This field is only available if you have previously created a GGSN config,
GGSN report, PDNGW config, PDNGW report, SGW config, SGW report, or General group. (See
Creating Groups, page 11-29).

In the Select Nodes to Search field, select all the Nodes on which you want to search for the MSISDN
you entered. Click Select All to check all boxes and search all the nodes. Click Deselect All to clear all
check boxes.

To conduct the search, click the Search button.

The Search Results popup window appears.
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Step6  If the search is successful, you can select from the matching nodes to troubleshoot the subscriber by
clicking the Troubleshoot Subscriber button in the Search Results popup.

Understanding Groups

MWTM allows you to create groups of nodes that can simplify operations. You can create groups using
the MWTM web interface and then perform operations against all nodes of a group instead of performing
the operation against each node individually. You can also perform searches on groups. For example, you
can search for a home agent subscriber on nodes within a specific group.

For provisioning groups, the master node is the first node in the group. The master node is used to
determine provisioning commands.

Related Topics
e Creating Groups, page 11-29

e Editing Groups, page 11-30

e Viewing Group Summary Information, page 11-31

Creating Groups
~

Note  This option is available to users with authentication level Power User (level 2) and higher.

You can create the following types of groups:

Step 1 From the web interface, click Groups.
Step2  Click the Create icon. The New Group form appears.
Step3  Complete the New Group fields:
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Field

Description

Name

Enter a name for the group

Type

From the pulldown menu, select the group type:
CSG configuration

CSG report

GGSN configuration

GGSN report

General—Any node can be in the general group.

HA configuration

HA report

IPRAN configuration
RAN-O configuration
PDNGW configuration
PDNGW report

SGW configuration
SGW report

mSEF configuration

~

Note

Stepd4  Click OK.

If a group contains non-existent nodes or if you add a node of the wrong type to a group, the
group will be invalid.

The Edit window appears displaying information about the group you just created. See Viewing Group
Summary Information, page 11-31 for more information.

Related Topics

e Understanding Groups, page 11-29

e Editing Groups, page 11-30

e Viewing Group Summary Information, page 11-31

Editing Groups

After you have created a group, you can add nodes to and remove nodes from the group. You can also
order the nodes within the group.
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Note

Step 1
Step 2
Step 3

Step 4

Step 5
Step 6

Viewing Group Summary Information ||

This option is available to users with authentication level Power User (level 2) and higher. If you do not
have the required privileges you will not see the Edit tab.

From the web interface, click Groups > group name.
Click the Edit tab. The Group Settings pane displays the group name and group type.

In the Group Members pane, specify to display available members by Nodes or by Groups. You might
want to view members by Group if you want to copy all members of one group to another group. The
available members or groups are displayed.

a~

Note  Only valid nodes for a group are displayed in the Available members/groups list. A group is
invalid if it contains non-existent nodes or if the group contains nodes of the wrong type.

Click on a member or group to add to the specified group, then click Add. The member or group is added
to the Selected Members list.

To remove a member, click on the member in the Selected Members list, then click Remove.
To order the nodes in a group, use the Raise and Lower buttons.

For provisioning groups, the master node is the first node in the group. The master node is used to
determine provisioning commands.

Viewing Group Summary Information

~

Note

From the web interface navigation tree, click Groups to display the Group Summary List.

Some table columns are hidden by default. Right-click on the web table header to see all columns.

Field Description

Internal ID Internal ID of the object. The internal ID is a unique ID for every object, which the
MWTM assigns for its own internal use. This ID can also be useful when the TAC
is debugging problems.

Name Name of the group.

Group Type Type of group.

Size Number of nodes in the group.

Notes Displays any notes attached to the group.

Valid Yes indicates the group is valid. No indicates the group is not valid. A group is
invalid if it contains non-existent nodes or if the group contains nodes of the wrong
type.

Create Time The time at which the group was created.

Last Updated Date and time the MWTM last updated the information on the page.
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Displaying

Step 1

Field Description

Create User The IP address from which the group was created.
Last Changed Displays the local IP Address.

User

Last Verified Time and date group was last verified.

Group Details

From the web interface, click Groups > group name. You can click on any of the following tabs for more
information about the specified group:

Details—See Viewing Group Details, page 11-32.
Notes—See Viewing Notes, page 8-55.

Events—Displays events associated with the nodes in the group only. See Displaying Alarms and Events,
page 11-19.

Alarms—Displays alarms associated with the nodes in the group only. See Displaying Alarms and
Events, page 11-19.

Edit—See Editing Groups, page 11-30.

Viewing Group Details

Step 1
Step 2

From the web interface, click Groups > group name.

Click Details. Detailed information about the specified group is displayed. See Nodes Table, page 8-8
for descriptions of the fields.

The Group Member Verification Status field specifies that status of each group member as it exists in the
group. If the group is not valid, this field indicates which node is causing the group to not be valid.

Batch Provisioning

Note

The MWTM provides a popup text field where you can type any CLI commands and then have those
stored in a file on the server. These commands can then be used in batch operations to push out config
changes to the nodes where there is no direct support in the wizard GUI interface. Also, MWTM stores
some sample batch config files in the path /opt/CSCOsgm/etc/batch that gives you an example how these
work.

You can not delete the sample batch config files and also you can not create a batch file with the name
starting with “SampleConfig” through batch file editor.
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The MWTM uses the existing “Groups” feature to create group objects. Once you have a group to
provision (see Using the Provisioning Wizard, page 7-48), select the group from left panel and then
choose Actions > Batch Provision from the toolbar. The page gets loaded with the Batch Provision

page.

Note  The Batch Provision option is available only for the users with authentication level 3 and above. Also,
the Batch Provision is not available for a group of the type “Report”.

The Batch Provision page contains:

Field or Button Description
Back Use this button to go back to the previous page.
Load File Opens the MWTM: File Dialog window, which allows you to load the batch files.
=] Save File Saves the changes you have made to the chosen batch file. The saved batch files are added in

the path /opt/CSCOsgm/etc/batch with the naming convention
“$Name.99.9(99).Generic.batch”.

Note  When you load the sample batch config files, the Save File button gets disabled.

Save As Click this to save the updated batch file with a new name, or to overwrite an existing batch
] file. Opens the MWTM: File Dialog window with the addition of a text field “Filename”
where you can specify the new name for the batch file. If an existing file name is given in the
“File Name” text field, a confirmation dialog box is displayed asking whether to overwrite
the existing file. The saved batch files are added in the path /opt/CSCOsgm/etc/batch with the
naming convention “$Name.99.9(99).Generic.batch”.

Write Mem Click this check box to save the script to the running configuration.

Provision Allows you to perform batch provisioning for the nodes in the selected group. Opens Add
credential for all nodes in the group window.

Batch File Text area to display or edit the contents of the batch file.

This text area is empty and the title displays “Batch File: No File” when there is no batch
file loaded. Once the batch files are loaded (using the Load File option), the text area
displays the contents of the loaded batch file and the title of the text area changes to
Batch File: filename, where filename is the name of the batch file.

You can also enter the device level commands in this text area to provision the nodes in
the selected group.

MWTM: File Dialog

The MWTM: File Dialog window contains:
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Field or Button

Description

Batch File List

The Batch File List pane contains the following columns:
e Type—Icon indicating the item in the table is a file.
e Name—Name of the batch file.

e Node Type—Type of node. See Nodes Table, page 8-8, for a list of the available node
types.
e Last Modified—Date and time the batch file or folder was last modified.

e Size (bytes)—Size of the batch file or folder, in bytes.

OK Loads the chosen batch file and closes the dialog box. To load a batch file, select the file
in the list and click OK. The batch file is loaded properly in the “Batch File:” text area
panel of the “Batch Provision” page.

Delete Deletes the chosen file from the batch file list. The MWTM displays a confirmation
message before deleting the file.

Cancel Closes the dialog box without loading a batch file or saving any changes to the batch file
list.

Help Displays online help for the dialog box.

Add credential for all nodes in the group

The Add credential for all nodes in the group window contains:

Field or Button Description
User Name Enter the login username.
Password Enter the login password.

Enable User Name

Enter the login enable username.

Enable Password

Enter the login enable password.

OK Adds the new credential information to the MWTM database.
Cancel Closes the current window without saving the changes.
Help Displays the online help for the window.

Viewing Statistics
You can use statistics for capacity planning and trend analysis. For example, you can generate graphs,
tables, or CSV files:
e For a specified time range to display historical statistics for customer busy-hours.
e To show the maximum send and receive traffic over a specified time period.
e To show data on a 15-minute, daily, or hourly basis.

MWTM provides two types of statistics:
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e Real-time statistics—The MWTM provides real-time (not historical) performance statistics and
error information occurring in real time. The MWTM client also displays graphs for real-time
statistics. You use real-time statistics for troubleshooting active problem areas in your network.

e Historical reports (statistics). These reports are available on the MWTM web interface only.

These statistics vary by the time frame over which they are collected and stored and for some
domains, the statistics gathered vary. For example, real-time SCTP Association Statistic Details
describes link-level SCTP statistics collected every 15 seconds. The SCTP historical reports
describe device-level SCTP statistics for all of the SCTP links on a specific device over 15 minute,
hourly, and daily intervals.

Displaying RAN-0 Statistics

Note

You can view real-time performance data for a shorthaul or backhaul interface in the MWTM:

e Web interface by selecting a shorthaul or backhaul interface in the navigation tree and clicking the
Shorthaul Performance or Performance tab in the right pane.

¢ Client interface by right-clicking a shorthaul or backhaul interface in the navigation tree and
clicking Performance History. The MWTM client interface provides access to RAN-O real-time
performance statistics that you can use to troubleshoot problems that occur in real time. The zoom
and navigation features quickly enable isolating and focusing on a problem area.

If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible
10S software, from the MWTM:

e Web interface, choose Administrative > IPRAN OS README.

e (Client interface, choose View > MWTM Web Links > Administrative; then click IPRAN OS
README.

The Performance tab shows one or more graphs depending on the type of report chosen. These graphs
depict send and receive rates of optimized IP traffic over a specified time range. The graphs display the
traffic in bits per second. Each data series shows maximum, minimum, and average rates of optimized
traffic.

The Performance tab for a backhaul interface shows total rates for GSM and UMTS traffic, including
total error rates.

This section provides information about:
e Displaying Shorthaul Performance Statistics, page 11-35
¢ Displaying Backhaul Performance Statistics, page 11-36

Displaying Shorthaul Performance Statistics

The Shorthaul Performance tab for a shorthaul interface shows the maximum, minimum, and average
rates for send and receive traffic.

[ oL-23900-01

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 g



Chapter 11 Accessing Data from the Web Interface

M Displaying RAN-O Statistics

The Shorthaul Performance tab for a shorthaul interface contains:

GUI Element Description

Toolbar Provides functions to select a report type, duration, output type. See Using the Toolbar, page 11-6.

Type A comprehensive summary of minimum, average, and maximum capacity statistics for send and receive
traffic on a RAN shorthaul. You can choose from 15-minute, hourly, or daily capacity summary reports,
or choose a custom range.

Table If you select the Output Type Table, the table contains:

e Data Type—Type of data, send or receive

e Average—Average of the data across the chosen time range

e Minimum—Minimum value across the chosen time range

¢ Minimum Timestamp EDT—Time the minimum value occurred
e Maximum—Maximum value across the chosen time range

e Maximum Timestamp EDT—Time the maximum value occurred

Note  If the Output Type is Table or CSV, the same data is presented but the column headings are labeled
by data type (for example, Send Average and Receive Average).

Expand to Full
Screen

If Output Type is Graph, this text link displays the graph in a new, full-screen window for easier viewing.

Bits/Sec or

If Output Type is Graph, Y-axis label that shows traffic rate in bits per second. The Y axis automatically

Bytes/Sec scales to the interface speed.
Note If no data exists between any two data points, the graph displays a color-coded vertical bar to show
the period for which no data is available.
Time If Output Type is Graph, X-axis label that shows a historical time scale and the server time zone.
Legend If Output Type is Graph, color-coded legend that shows labels for traffic rates.

Displaying Backhaul Performance Statistics

The Performance tab for a backhaul interface shows minimum, average, and maximum traffic rates for
send and receive traffic. You can also determine the percentage of backhaul utilization that various traffic
types occupy. Error rates appear, too.
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The Performance tab for a backhaul interface contains:

GUI Elements Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the
“Using the Toolbar” section on page 11-6.

Type Report Type. If you choose a Capacity Summary report, the report shows a comprehensive summary of
minimum, average, and maximum capacity statistics for total traffic (GSM-Abis and UMTS-Iub), total
GSM-Abis traffic, and total UMTS-Iub traffic. You can choose from 15-minute, hourly, or daily capacity
summary reports. Error rates appear, too.

If Output Type is Graph, statistics appear in these graphs:

e Top—Capacity statistics for send traffic rates, including percentage of backhaul utilization (right side
of graph).

e Middle—Capacity statistics for receive traffic rates, including percentage of backhaul utilization
(right side of graph).

e Bottom—Error counts for send and receive traffic.

Type (continued) |If you choose a Minimum, Average, or Maximum Capacity report, the tables and graphs show capacity
statistics for the backhaul interface. You can choose from 15-minute, hourly, or daily capacity reports.

If Output Type is Graph, send and receive rate statistics appear in separate panes. Each pane shows two
fully expandable graphs:

e Top—Shows total (GSM-Abis and UMTS-Iub), total GSM-Abis, and total UMTS-Iub traffic rates,
including percentage of backhaul utilization (right side of graph).

e Bottom—Shows traffic rates for each shorthaul interface that belongs to the backhaul.

Table Note Different tables appear depending on the report Type and Output Type selections.

If the Output Type is Graph, a table appears with these columns:
e Data Type—Type of data, send or received
e Average—Average of the data across the chosen time range
e Minimum—Minimum value across the chosen time range
e Minimum Timestamp EDT—Time the minimum value occurred
e Maximum—Maximum value across the chosen time range
e Maximum Timestamp EDT—Time the maximum value occurred
Note If the Output Type is Table or CSV, similar data is presented but the column headings may vary.
Also, if the value is N/A, that means no data is available.
Another table has these columns:

e Data Type—Category of error for which statistics are gathered. Types include optimization, missed
packets, and miscellaneous errors.

e Total Counts—Total error count for each type of error.

e Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over the
duration of the data range that you chose.

Note  You can sort the contents of the columns in ascending or descending order by clicking the column
heading.
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GUI Elements Description

Expand to Full If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.
Screen

Bits/Sec or If Output Type is Graph, primary Y-axis label (left side of graph) that shows traffic rate in bits per second.
Bytes/Sec The Y axis automatically scales to the User Bandwidth.

If no data exists between any two data points, the graph displays a color-coded vertical bar to show the
period for which no data is available.

% Utilization If Output Type is Graph, secondary Y-axis label (right side of graph) that shows the backhaul utilization
as a percentage of the User Bandwidth. The graph background has horizontal bars that are color-coded to
indicate these thresholds:

e Overloaded—Top portion of graph.
e Warning—Middle portion of graph.
e Acceptable—Bottom portion of graph.
For definitions of these thresholds, see the “Threshold Information (RAN-O Only)” section on page 7-35.

Note If the% Utilization exceeds 100%, see Why does my backhaul graph show greater than 100% for
transmit traffic?, page C-24.

Time X-axis label that shows a user-specified, historical time scale and the server time zone.

Legend Color-coded legend that shows labels for traffic and error rates.

Displaying Error Statistics

You can view error data for a shorthaul or backhaul interface in the MWTM:

e Web interface by selecting an interface in the navigation tree and clicking the Shorthaul Errors or
Errors tab in the content area.

e Client by right-clicking an interface in the navigation tree and clicking Error History.
~

Note  If the CISCO-IP-RAN-BACKHAUL-MIB on the node is not compliant with the MWTM, the MWTM
issues the message:

MIB not compliant for reports

Install a version of IOS software on the node that is compatible with the MWTM. For a list of compatible
10S software, from the MWTM:

e Web interface, choose Administrative > IPRAN OS README.

e (lient interface, choose View > MWTM Web Links > Administrative; then click IPRAN OS
README.

You view error data for a shorthaul or backhaul interface by selecting the interface in the navigation tree
and clicking the Errors tab in the content area. The Errors tab shows total error counts and average error
rates in table and graph format.

This section provides information about:
e Displaying Shorthaul Error Statistics, page 11-39
e Displaying Backhaul Error Statistics, page 11-40

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
m. 0L-23900-01 |



| Chapter11  Accessing Data from the Web Interface

Displaying RAN-O Statistics

Displaying Shorthaul Error Statistics

The Shorthaul Errors tab for a shorthaul interface shows a single table and a graph that shows the error
rates and counts for different types of GSM-Abis and UMTS-Iub errors.

The Shorthaul Errors tab for a shorthaul interface contains:

GUI Elements Description

Toolbar Provides functions to select report type, duration, and output type. See the “Using the Toolbar” section
on page 11-6.

Type Report Type. If you choose an Error Summary report, the table and graph display a comprehensive

summary of total error counts and average error rates for protocol, missed-packet, and miscellaneous
errors for the chosen shorthaul. You can choose from 15-minute, hourly, or daily error summary reports.
Statistics appear in table and graph format.

If you choose an error report that is not a summary report, the table and graph displays protocol, missed
packet, or miscellaneous errors for the shorthaul interface. You can choose from 15-minute, hourly, or
daily error reports. Statistics appear in table and graph format.

For definitions of these error types, see:
e Protocol Failures, page 7-116
e Miscellaneous, page 7-117
e Missed Packets, page 7-118

Table Note Different tables and column headings appear depending on the report Type and Output Type
selections.
If Output Type is Graph, a table appears with these columns:

e Data Type—Category of error for which statistics are gathered. Types include protocol, missed
packets, and miscellaneous errors.

e Total Counts—Total error count for each type of error.

e Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.
Depending on the report Type selection, if the Output Type is Table or CSV, a table appears with

multiple columns showing various error types and their counts. For definitions of these error types, see
the:

e Protocol Failures, page 7-116
e Miscellaneous, page 7-117
e Missed Packets, page 7-118

Note  You can sort the contents of the columns in ascending or descending order by clicking the
column heading.

Expand to Full If Output Type is Graph, this text link displays a graph in a new, full-screen window for easier viewing.
Screen
Error Counts If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second.

Note If no data exists between any two data points, the graph displays a color-coded vertical bar to
show the period for which no data is available.
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GUI Elements

Description

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server
time zone.
Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates.

Displaying Backhaul Error Statistics

The Errors tab for a RAN backhaul interface shows a single table and a graph that shows the error rates
and counts for different interfaces belonging to the backhaul.

The Errors tab for a backhaul interface contains:

GUI Elements

Description

Toolbar Provides functions to select a report type, duration, output type, and the Graph Series Editor. See the
“Using the Toolbar” section on page 11-6.
Table Note Different tables and column headings appear depending on the report Type and Output Type

selections.

If Output Type is Graph, a table appears with these columns:

e Data Type—Category of error for which statistics are gathered. Types include optimization, missed
packets, and miscellaneous errors.

¢ Total Counts—Total error count for each type of error.

e Avg. Error Rate (Per Sec)—The calculated average error rate per second for each error type over
the duration of the data range that you chose.

Note If the value is N/A, that means no data is available.
If Output Type is Table, a table appears with columns for total error counts for various error types (for
example, total GSM-Abis errors).

Note  You can sort the contents of the columns in ascending or descending order by clicking the
column heading.

Expand to Full
Screen

If Output Type is Graph, text link that shows a graph in a new, full-screen window for easier viewing.

Error Counts

If Output Type is Graph, Y-axis label on left side of graph that shows traffic rate in bits per second.

Time If Output Type is Graph, X-axis label that shows a user-specified, historical time scale and the server
time zone.
Legend If Output Type is Graph, color-coded legend that shows labels for traffic and error rates (for example,

Total Errors UMTS-Iub).

Generating RAN Data Export Files

You can easily generate historical reports for RAN backhauls and shorthauls in the web interface. You
can then export this data to a report with comma-separated values (CSV file). You can save this file to
disk or open it with an application that you choose (for example, Microsoft Excel).
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To export RAN data:

Step 1 Select a RAN backhaul or shorthaul in the navigation tree of the web interface.
Step2  Click the Performance or Errors tab in the right pane.
Step3  Generate a report.

Step4  Choose CSV from the Type drop-down menu.

Displaying CSG2 Real-Time Statistics

The MWTM enables you to display real-time statistics for CSG2 nodes in the MWTM web interface. To
display real-time statistics, select the node in the navigation tree and click the Statistics tab. The
following options appear under the Type drop-down menu:

e Global Statistics, page 11-41

¢ (CSG?2 Protocol, page 11-46

¢ Gx Global Statistics, page 11-47

e Gx Policy Preload, page 11-49

e Gx Policy Preload Ext, page 11-50

e Gx PCRF Method List Message, page 11-52

e Gx PCRF Method List Message Error, page 11-53
¢ Billing Plan Statistics, page 11-54

Global Statistics
A

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the Global Statistics table, choose this option from the Type drop-down menu. The GUI displays
the following categories:

e Global Statistics, page 11-42

e Load Statistics, page 11-42

e BMA Statistics, page 11-44

¢ Quota Server Statistics, page 11-45
e User Database Statistics, page 11-46
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Global Statistics

The Global Statistics pane contains:

Field

Description

User Current

The total number of users with one or more active sessions on the system.

Session Current

The total number of sessions on the system. A session corresponds to a transmission control
protocol (TCP) or user datagram protocol (UDP) flow.

User High Water

The highest number of active users reported by the User Current field since its last reset.

Session High Water

The highest number of active sessions reported by the Session Current field since its last reset.

User License

Number of users allowed by the license.

The following statistics are available only on CSG2, Release 2, for devices running 10S 12.4(15) or later.

GTP BMA Rejected

Number of messages received from all the Billing Mediation Agents (BMAs) with reject cause
code.

GTP BMA Dropped

Total Number of messages dropped destined for any of the BMAs

GTP BMA Retransmit

Number of messages retransmitted to all BMAs.

GTP QuotaMgr Rejected

Number of messages received from all the Quota Managers with reject cause code.

GTP QuotaMgr Dropped

Total Number of messages dropped destined for any of the Quota Managers.

GTP QuotaMgr
Retransmit

Number of messages retransmitted to all the Quota Managers.

Load Statistics

Load statistics are available only on CSG2, Release 2, for devices running IOS 12.4(15) or later.

The Load Statistics pane contains:

Description

Statistics Type

Column

Defines the type of statistics for each row:
e Radius Start Requests
e Session Create Requests
e BMA Messages
e Messages to Quota Server
e User Database Requests

e Gx Events (available only on CSG2, Release 3.5, for devices running
12.4(22)MDA1 or later)
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Radius Start
Requests

Description
Allowed Number of outgoing Radius Start requests allowed.
Allowed Rate Number of outgoing Radius Start requests allowed per second.

Allowed Peak

The highest number of outgoing Radius Start requests allowed per second.

IPC Queue Depth
Tolerance

Maximum queue depth for Radius Start requests in the (Inter Processor
Communication) IPC queue.

Denied

Number of outgoing Radius Start requests denied.

Denied Rate

Number of outgoing Radius Start requests denied per second.

Denied Peak

The highest number of outgoing Radius Start requests denied per second.

Session Create Allowed Number of outgoing Session Create Requests allowed.
Requests Allowed Rate Number of outgoing Session Create Requests allowed per second.
Allowed Peak The highest number of outgoing Session Create Requests allowed per second.
IPC Queue Depth  |Maximum queue depth for Session Create Requests in the IPC queue.
Tolerance
Denied Number of outgoing Session Create Requests denied.
Denied Rate Number of outgoing Session Create Requests denied per second.
Denied Peak The highest number of outgoing Session Create Requests denied per second.
BMA Messages Allowed Number of outgoing BMA messages allowed.

Allowed Rate

Number of outgoing BMA messages allowed per second.

Allowed Peak

The highest number of outgoing BMA messages allowed per second.

IPC Queue Depth

Maximum queue depth for BMA messages in the IPC queue.

Tolerance
Denied Number of outgoing BMA messages denied.
Denied Rate Number of outgoing BMA messages denied per second.
Denied Peak The highest number of outgoing BMA messages denied per second.
Messages to Quota |Allowed Number of outgoing messages to Quota Manager allowed.
Server Allowed Rate Number of outgoing messages to Quota Manager allowed per second.
Allowed Peak The highest number of outgoing messages to Quota Manager allowed per

second.

IPC Queue Depth

Maximum queue depth for messages to Quota Manager in the IPC queue.

Tolerance

Denied Number of outgoing messages to Quota Manager denied.

Denied Rate Number of outgoing messages to Quota Manager denied per second.

Denied Peak The highest number of outgoing messages to Quota Manager denied per second.
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Description
User Database Allowed Number of outgoing User Database requests allowed.
Requests Allowed Rate Number of outgoing User Database requests allowed per second.
Allowed Peak The highest number of outgoing User Database requests allowed per second.
IPC Queue Depth  |Maximum queue depth for User Database requests in the IPC queue.
Tolerance
Denied Number of outgoing User Database requests denied.
Denied Rate Number of outgoing User Database requests denied per second.
Denied Peak The highest number of outgoing User Database requests denied per second.
Gx Events Allowed Number of outgoing Gx Events allowed.
(available only on [ Ay, eq Rate Number of outgoing Gx Events allowed per second.
CSG2, Release 3.5,
for devices running | Allowed Peak The highest number of outgoing Gx Events allowed per second.
12.4(22)MDAI or  |IPC Queue Depth |Maximum queue depth for Gx Events in the IPC queue.
later) Tolerance
Denied Number of outgoing Gx Events denied.

Denied Rate

Number of outgoing Gx Events denied per second.

Denied Peak

The highest number of outgoing Gx Events denied per second.

BMA Statistics
The Billing Mediation Agent (BMA) Statistics pane contains:

Column Description

Server Name of the BMA server.

Port The UDP port of the BMA.

VRF Name Name of the virtual routing and forwarding (VRF) over which communication with BMA occurs. If no
VRF is specified, the global routing table is used.

State The state of the BMA. Possible states include:

Standby—The server is prepared to become active.

Failed—The server has failed to respond to requests.

Active—The server has been activated to receive requests.

Echowait—An echo request to this billing mediation agent is waiting for a response.

Nawait—A node-alive request to this billing mediation agent is waiting for a response.

Suspended—The server has received a stop request from the operator.

Lost Records

Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the billing mediation agent.

Failed Acks Number of acknowledgments received from the billing mediation agent for which there are no
outstanding requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or

down) since the last poll.
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Column Description

Outstanding High  |The highest number of messages waiting for acknowledgements as reported by the Outstanding field
Water since its last reset.

Bad Records Number of bad records received. These are records in which an error was detected while attempting to
decode the contents.

Retransmits Number of messages retransmitted to the billing mediation agent.

Sent Rate Rate at which records are sent to the billing mediation agent.

The following statistics are available only on CSG2, Release 2, for devices running 10S 12.4(15) or later.

Rate Interval The duration of time interval in Packet Rate and Ack Rate.
Packet Rate Number of packets sent to the BMA per second calculated over the interval indicated by Rate Interval.
Ack Rate Number of acknowledgments received from the BMA per second calculated over the interval indicated

by Rate Interval.

Quota Server Statistics

The Quota Server Statistics pane contains:

Column Description

Server Name of the quota server.

Port The UDP port of the quota server.

VRF Name Name of the Virtual Routing and Forwarding (VRF) over which communication with the quota server

occurs. If no VRF is specified, the global routing table is used.

State The state of the quota manager. Possible states include:

e Standby—The quota manager is prepared to become active.

e Failed—The quota manager has failed to respond to requests.

e Active—The quota manager has been activated to receive requests.

e Echowait—An echo request to this quota manager is waiting for a response.

e Nawait—A node-alive request to this quota manager is waiting for a response.

e Suspended—The quota manager has received a stop request from the operator.

Lost Records Total number of lost records since system initialization or the last time the counter wrapped.

Total Sent Total number of records sent to the quota server.

Failed Acks Number of acknowledgments received from the quota server for which there are no outstanding
requests.

Outstanding Current number of messages waiting to be acknowledged. An arrow icon indicates the trend (up or

down) since the last poll.

Outstanding High  |The highest number of messages waiting for acknowledgements as reported by the Outstanding field
Water since its last reset.

Bad Records Number of bad records received. These are records in which an error was detected while attempting to
decode the contents.

Retransmits Number of messages retransmitted to the quota manager.

Sent Rate Rate at which records are sent to the quota server.
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Column

Description

The following statistics are available only on CSG2, Release 2, for devices running 10S 12.4(15) or later.

Rate Interval

The duration of time interval in Packet Rate and Ack Rate.

Packet Rate

Number of packets sent to the Quota Manager per second calculated over the interval indicated by Rate
Interval.

Ack Rate

Number of acknowledgments received from the Quota Manager per second calculated over the interval
indicated by Rate Interval.

User Database Statistics

The user database is a service that translates a client IP address into a user identifier. The User Database
Statistics pane contains:

Column Description
Server Name of the user database server.
Port The listening UDP port of the server.
VRF Name Name of the VRF over which communication with user data server occurs. If no VRF is specified, the
global routing table is used.
State State of the user database. Possible values include:
Reset—State before the database is determined to be active.
Active—The database is available and processing requests.
Failed—The database has failed and is not processing requests.
Requests Number of user database requests.

User Identifiers
Returned

Number of user identifiers returned.

Requests Resent

Number of user database requests resent.

Request Timeouts

Number of user database requests that have timed out.

Request Errors

Number of errors returned on user database requests.

Requests Rate

Rate of user database requests.

User Identifiers
Returned Rate

Rate at which user identifiers are returned.

CSG2 Protocol

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the CSG2 Protocol statistics, choose this option from the Type drop-down menu. The GUI
displays:
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Column Description

Inspection Method |Type of inspection method used to identify the protocol.

Protocol Protocol name used in the configuration of the entity which provides the content services.

Transactions e Count—Total number of transactions occurred in the network.
e Rate—Number of transactions occurred in the network per second.

e Peak—The highest number of transactions occurred in the network per second.

Subscriber Send e Count—Total number of outgoing subscriber packets.

Packets e Rate—Number of outgoing subscriber packets per second.

e Peak—The highest number of outgoing subscriber packets per second.

Subscriber Send e Count—Total number of outgoing subscriber bits.

Bits e Rate—Number of outgoing subscriber bits per second.

e Peak—The highest number of outgoing subscriber bits per second.

Network Send e Count—Total number of outgoing network packets.

Packets e Rate—Number of outgoing network packets per second.

e Peak—The highest number of outgoing network packets per second.

Network Send Bits | ¢ Count—Total number of outgoing network bits.

e Rate—Number of outgoing network bits per second.

e Peak—The highest number of outgoing network bits per second.

Gx Global Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx Global statistics, choose this option from the Type drop-down menu. The GUI displays
the following categories:

e Global Message Statistics, page 11-47
¢ Global Message Error Statistics, page 11-48

Global Message Statistics

The Global Message Statistics pane contains:

Column Description
Active Sessions Total number of active sessions.
Credit Control Total number of CCR-Initial messages sent.

Request Initial
Messages Sent

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Column

Description

Credit Control
Request Initial
Messages Sent Rate

Rate at which CCR-Initial messages are sent.

Credit Control
Request Update
Messages Sent

Total number of CCR-Update messages sent.

Credit Control
Request Update
Messages Sent Rate

Rate at which the CCR-Update messages are sent.

Credit Control
Request Final
Messages Sent

Total number of CCR-Final messages sent.

Credit Control
Request Final
Messages Sent Rate

Rate at which the CCR-Final messages are sent.

Credit Control
Answer Messages
Received

Total number of CCA messages received.

Credit Control
Answer Messages
Received Rate

Rate at which the CCA messages are received.

Reauthorization
Request Messages
Received

Total number of RAR messages received.

Reauthorization
Request Messages
Received Rate

Rate at which the RAR messages are sent.

Reauthorization
Answer Messages
Sent

Total number of RAA messages sent.

Reauthorization
Answer Messages
Sent Rate

Rate at which the RAA messages are sent.

Global Message Error Statistics

The Global Message Error Statistics pane contains:

Column

Description

Credit Control
Response Failures

Number of failures to send CCR.

Invalid Message
Type Errors

Total number of invalid message type errors.

Duplicate Request
Errors

Total number of duplicate request type errors.
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Column Description

Credit Control Total number of errors occurred in CCA.
Answer Errors

Reauthorization Number of failures to send RAA.
Answer Failures

Reauthorization Total number of errors occurred in RAR.
Response Errors

Invalid Request Number of errors due to invalid request type.
Type Errors

Invalid Request Number of errors due to invalid request number.
Number Errors

Invalid Request Number of errors due to invalid request status.
Status Errors

Invalid Session ID |Number of times the session id received does not exist or when the session id associated with request
Errors is not the same as the one received.

Gx Policy Preload
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx Policy Preload statistics, choose this option from the Type drop-down menu. The GUI
displays the following categories:

e Policy Preload Statistics, page 11-49
e Policy Preload Error Statistics, page 11-50

Policy Preload Statistics

The Policy Preload Statistics pane contains:

Column Description

PCEF Initiated Number of PCEF initiated preloading.
Preloading

PCREF Initiated Number of PCRF initiated preloading.
Preloading

Policy Preload Number of Policy Preload requests.
Requests

Policy Preload Number of Policy Preload responses.
Responses

Global Policy Push |Number of Global Policy Push.

Count

Global Policy Push |Number of Global Policy Push Acknowledgement.
Acknowledgement

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Policy Preload Error Statistics

The Policy Preload Error Statistics pane contains:

Column Description
Preload Data Number of times the preload data is inconsistent.
Inconsistent

Attribute Value
Pairs Missing

Number of times the mandatory AVPs (Attribute Value Pairs) are missing.

Wrong Order
Failures

Number of failures due to wrong order.

Enforcement
Failures

Number of failures to enforce.

Static configuration
Conlflicts

Number of conflicts with static config.

Credit Control
Request Failures

Number of times failed to CCR (Credit Control Request).

Invalid Message
Type Errors

Number of invalid message type errors.

Credit Control
Answer Errors

Total number of errors occurred in CCA (Credit Control Answer).

Reauthorization
Answer Failures

Number of times failed to send RAA (Re-Authorization Answer).

Reauthorization
Response Errors

Total number of errors occurred in RAR (Re-Authorization Request).

Invalid Request
Type Errors

Number of invalid req-type errors.

Invalid Request
Number Errors

Number of invalid req-num errors.

Invalid Request
Status Errors

Number of invalid req-status errors.

Invalid Session ID
Errors

Number of times the session id received does not exist or when the session id associated with request
is not the same as the one received.

Preload Timeout
Errors

Number of times the preload timeout occurs.

Gx Policy Preload Ext

~

Note

For toolbar details, see Using the Toolbar, page 11-6.
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To view the Gx Policy Preload Ext statistics, choose this option from the Type drop-down menu. The
GUI displays:

Field or Column

Description

Delete Failed

Service Contents—Number of times deletion of service contents has failed during preload.

Accounting Policy Maps—Number of times deletion of accounting policy-maps has failed during
preload.

Billing Services—Number of times deletion of billing services has failed during preload.
Content Policies—Number of times deletion of content policies has failed during preload.

Billing Plans—Number of times deletion of billing plans has failed during preload.

Deleted

Service Contents—Number of service contents deleted during preload.

Accounting Policy Maps—Number of accounting policy-maps deleted during preload.
Billing Services—Number of billing services deleted during preload.

Content Policies—Number of content policies deleted during preload.

Billing Plans—Number of billing plans deleted during preload.

Insert Failed

Service Contents—Number of times insertion of service contents has failed during preload.

Accounting Policy Maps—Number of times insertion of accounting policy-maps has failed during
preload.

Billing Services—Number of times insertion of billing services has failed during preload.
Content Policies—Number of times insertion of content policies has failed during preload.

Billing Plans—Number of times insertion of billing plans has failed during preload.

Inserted

Service Contents—Number of service contents inserted during preload.

Accounting Policy Maps—Number of accounting policy-maps inserted during preload.
Billing Services—Number of billing services inserted during preload.

Content Policies—Number of content policies inserted during preload.

Billing Plans—Number of billing plans inserted during preload.
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Field or Column

Description

Roll Back Failed

e Service Contents—Number of times rollback has failed on insertion or deletion of service contents
during preload.

e Accounting Policy Maps—Number of times rollback has failed on insertion or deletion of
accounting policy-maps during preload.

¢ Billing Services—Number of times rollback has failed on insertion or deletion of billing services
during preload.

e Content Policies—Number of times rollback has failed on insertion or deletion of content policies
during preload.

e Billing Plans—Number of times rollback has failed on insertion or deletion of billing plans during
preload.

Rolled Back

e Service Contents—Number of times the rollback is successful on insertion or deletion of service
contents during preload.

e Accounting Policy Maps—Number of times the rollback is successful on insertion or deletion of
accounting policy-maps during preload.

e Billing Services—Number of times the rollback is successful on insertion or deletion of billing
services during preload.

¢ Content Policies—Number of times the rollback is successful on insertion or deletion of content
policies during preload.

e Billing Plans—Number of times the rollback is successful on insertion or deletion of billing plans
during preload.

Gx PCRF Method List Message

~

Note  For toolbar details, see Using the Toolbar, page 11-6.
To view the Gx PCRF Method List Message statistics, choose this option from the Type drop-down
menu. The GUI displays:
Column Description
Method List Name |Method list name.

Credit Control
Request Initial
Messages Sent

e Count—Total number of CCR-Initial messages sent.

e Rate—Rate at which CCR-Initial messages are sent.

Credit Control
Request Update
Messages Sent

e Count—Total number of CCR-Update messages sent.

e Rate—Rate at which the CCR-Update messages are sent.

Credit Control
Request Final
Messages Sent

¢ Count—Total number of CCR-Final messages sent.

e Rate—Rate at which the CCR-Final messages are sent.

Credit Control
Answer Messages
Received

e Count—Total number of CCA messages received.

e Rate—Rate at which the CCA messages are received.
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Column

Description

Reauthorization
Request Messages
Received

e Count—Total number of RAR messages received.

e Rate—Rate at which the RAR messages are sent.

Reauthorization
Answer Messages
Sent

e Count—Total number of RAA messages sent.

e Rate—Rate at which the RAA messages are sent.

Gx PCRF Method List Message Error

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the Gx PCRF Method List Message Error statistics, choose this option from the Type drop-down

menu.

The GUI displays:

Column

Description

Method List Name

Method list name.

PCRF Reboots

Number of times PCRF reboots.

Invalid Message
Type Errors

Total number of invalid message type errors.

Duplicate Request
Errors

Total number of duplicate request type errors.

Credit Control
Response Failures

Number of failures to send CCR.

Credit Control
Answer Errors

Total number of errors occurred in CCA.

Reauthorization
Answer Failures

Number of failures to send RAA.

Reauthorization
Response Errors

Total number of errors occurred in RAR.

Invalid Request
Type Errors

Number of errors due to invalid request type.

Invalid Request
Number Errors

Number of errors due to invalid request number.

Invalid Request
Status Errors

Number of errors due to invalid request status.

Invalid Session ID
Errors

Number of times the session id received does not exist or when the session id associated with request

is not the same as the one received.
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Billing Plan Statistics

S

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the Billing Plan statistics, choose this option from the Type drop-down menu.

The GUI displays:

Column

Description

Billing Plan Name

Name of the billing plan.

Subscriber Count

Number of subscribers associated with a given Billing Plan.

Peak Subscriber
Count

The highest number of subscribers associated with a given Billing Plan.

If the device is not defined with Billing Plan Statistics, then the GUI displays the following error
message:

Billing Plan Statistics are not defined on the device

Displaying BWG Real-Time Statistics

Global

The MWTM enables you to display real-time statistics for Broadband Wireless Gateway (BWG) nodes
in the MWTM web interface. To display BWG real-time statistics, select a BWG node in the navigation
tree and click the Statistics tab. The following subtabs appear:

e Global, page 11-54
e Paths, page 11-62
e User Groups, page 11-63

The Global subtab shows global statistics for BWG nodes and contains:
e Status, page 11-55
e Creation and Deletion Statistics, page 11-55
e Miscellaneous Statistics, page 11-56
e Signaling Packet Statistics, page 11-57
e DHCP Packet Statistics, page 11-58
e Handoff Statistics, page 11-58
e Data Packet Statistics, page 11-59
e Dropped Packet Statistics, page 11-60
e Profile Statistics, page 11-61
e Rejected Statistics, page 11-62
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Note  For toolbar details, see Using the Toolbar, page 11-6.

Status

The Status pane shows:

Field Description
Version Software version of the BWG.
Description Description of the physical instance of the BWG.

Operational Status |Current operational state of the BWG.

Session Indicates whether session redundancy is enabled or disabled.
Redundancy Status

Creation and Deletion Statistics

The Creation and Deletion Statistics pane shows:

Field Description

Base Stations e Maximum—Maximum number of base stations that can be concurrently
supported by this BWG.

e Current—Current number of signaling paths to all base stations. One
signaling path is created between the BWG and each base station, so the
current number of signaling paths is equal to the number of base stations
currently connected to the BWG.

¢ Created Count—Total number of signaling paths created on this BWG which
include active and past signaling paths.

e Created Rate—Rate at which signaling paths are created.

¢ Deleted Count—Total number of signaling paths deleted on this BWG.
e Deleted Rate—Rate at which signaling paths are deleted.

Data Paths e Maximum—N/A

e Current—Current number of data paths to all base stations.

¢ Created Count—Total number of data paths created on this BWG which
include active and past data paths.

e Created Rate—Rate at which data paths are created.

e Deleted Count—Total number of data paths deleted on this BWG.

e Deleted Rate—Rate at which data paths are deleted.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Field Description

Subscribers e Maximum—Maximum number of subscribers that can be concurrently
supported by this BWG.

e Current—Number of subscribers currently connected to this BWG.

¢ Created Count—Total number of subscribers created on this BWG which
includes active and past subscribers

¢ C(Created Rate—Rate at which subscribers are created.
e Deleted Count—Total number of subscribers deleted on this BWG.

¢ Deleted Rate—Rate at which subscribers are deleted.

Sessions e Maximum—N/A
e Current—Number of sessions currently active on this BWG.

¢ Created Count—Total number of sessions created on this BWG which
include active and past sessions.

e C(Created Rate—Rate at which sessions are created.
e Deleted Count—Total number of sessions deleted on this BWG.

¢ Deleted Rate—Rate at which sessions are deleted.

Flows e Maximum—N/A
e Current—Current number of flows for all sessions active on this BWG.

e C(Created Count—Total number of flows created on this BWG which include
active and past flows.

e C(Created Rate—Rate at which flows are created.
e Deleted Count—Total number of flows deleted on this BWG.
¢ Deleted Rate—Rate at which flows are deleted.

Hosts e Maximum—N/A
¢ Current—Current number of hosts connected to this BWG.

¢ C(Created Count—Total number of hosts created on this BWG which include
active and past hosts.

e C(Created Rate—Rate at which hosts are created.
¢ Deleted Count—Total number of hosts deleted on this BWG.
¢ Deleted Rate—Rate at which hosts are deleted.

Miscellaneous Statistics

The Miscellaneous Statistics pane shows:

Field Description

Framed Routes Indicates the current number of unique framed routes downloaded from AAA and
inserted into the IP routing table on a gateway.

Framed Router Indicates the number of subscribers using framed routes.

Subscribers
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Field

Description

Auto-Provisioned
Sessions

Indicates the number of auto-provisioned sessions on gateway.

Redirected
Sessions

Indicates the number of sessions with all uplink IP packets redirected by the
gateway.

Networks Behind
Mobile Stations

Indicates the number of networks behind mobile stations.

Aged Out Hosts

¢ Count—Indicates the number of idle static hosts aged out.

e Rate—Rate at which idle static hosts are aged out.

Signaling Packet Statistics

The Signaling Packet Statistics pane shows:

Field Description
Pending e Count—Total number of signaling packets currently pending on this BWG
Processed ¢ Count—Total number of signaling packets processed by this BWG.
e Rate—Rate at which signaling packets are processed.
Requeued e Count—Total number of signaling packets that were requeued on this BWG.

e Rate—Rate at which signaling packets are requeued.

Congestion Drops

¢ Count—Number of signaling packets dropped when too many signaling
packets are queued. The current queue limit is 1000 packets.

e Rate—Rate at which signaling packets are dropped.

Service Disabled
Drops

¢ Count—Number of signaling packets dropped due to disabled service.

e Rate—Rate at which signaling packets are dropped.

Service Not Ready
Drops

e Count—Number of signaling packets dropped while in non-active state for
redundant configuration.

e Rate—Rate at which signaling packets are dropped.

Encapsulation
Errors Drops

¢ Count—Number of signaling packets dropped due to encapsulation errors.

e Rate—Rate at which signaling packets are dropped.

Disposed Drops

e Count—Number of signaling packets disposed by the BWG.

e Rate—Rate at which signaling packets are disposed.
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DHCP Packet Statistics

The DHCP Packet Statistics pane shows:

Field Description
Discover e Count—Number of DHCP discover packets.
e Rate—Rate at which DHCP packets are discovered.
Offer e Count—Number of DHCP offer packets.
e Rate—Rate at which DHCP packets are offered.
Request ¢ Count—Number of DHCP request packets.
e Rate—Rate at which DHCP packets are requested.
Decline e Count—Number of DHCP decline packets.
e Rate—Rate at which DHCP packets are declined.
Ack e Count—Number of DHCP acknowledged packets.
e Rate—Rate at which DHCP packets are acknowledged.
Nak e Count—Number of DHCP negatively acknowledged packets.
e Rate—Rate at which DHCP packets are negatively acknowledged.
Release e Count—Number of DHCP release packets.
e Rate—Rate at which DHCP packets are released.
Inform e Count—Number of DHCP inform packets.

e Rate—Rate at which DHCP packets are informed.

Lease Query

e Count—Number of DHCP lease query packets.
e Rate—Rate at which DHCP packets are lease queried.

Unknown

¢ Count—Number of DHCP unknown packets.
e Rate—Rate at which DHCP packets are unknown.

Handoff Statistics

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5

The Handoff Statistics pane shows:

Field Description
Successful ¢ Count—Number of successful session handoffs between Base Stations.
Handoffs

e Rate—Rate at which successful session handoffs occur.

Failed Handoffs

e Count—Number of failed session handoffs between Base Stations.

e Rate—Rate at which failed session handoffs occur.

Successful CMAC

Key Updates

e Count—Number of successful CMAC Key count updates related to handoff

between base stations.

e Rate—Rate at which successful CMAC Key count updates are received.

0L-23900-01



| Chapter 11

Accessing Data from the Web Interface

Displaying BWG Real-Time Statistics

Field

Description

Failed CMAC Key
Updates

Count—Number of failed CMAC Key count updates related to handoff
between base stations.

Rate—Rate at which failed CMAC Key count updates are received.

Successful Security
Key Updates

Count—Number of successful security key updates during handoff between
base stations.

Rate—Rate at which successful security key updates occur.

Failed Security Key
Updates

Count—Number of failed security key updates during handoff between base
stations.

Rate—Rate at which failed security key updates occur.

Data Packet Statistics

The Data Packet Statistics pane shows:

Field Description

Received IP e Count—Number of data packets received by the BWG.
Packets e Rate—Rate at which data packets are received by the BWG.
Received IP Bits e Count—Number of data bits received by the BWG.

Rate—Rate at which data bits are received by the BWG.

Sent IP Packets

Count—Number of data packets sent by the BWG.
Rate—Rate at which data packets are sent by the BWG.

Sent IP Bits

Count—Number of data bits sent by the BWG.
Rate—Rate at which data bits are sent by the BWG.

Redirected IP
Packets

Count—Number of IP packets redirected by the BWG.
Rate—Rate at which IP packets are redirected by the BWG.

Redirected IP Bits

Count—Number of IP bits redirected by the BWG.
Rate—Rate at which IP bits are redirected by the BWG.

Received Ethernet
Packets

Count—Number of ethernet packets received by the BWG.
Rate—Rate at which IP packets are redirected by the BWG.

Received Ethernet
Bits

Count—Number of ethernet bits received by the BWG.
Rate—Rate at which ethernet bits are received by the BWG.

Sent Ethernet
Packets

Count—Number of ethernet packets sent by the BWG.
Rate—Rate at which ethernet packets are sent by the BWG.

Sent Ethernet Bits

Count—Number of ethernet bits sent by the BWG.
Rate—Rate at which ethernet bits are sent by the BWG.

Redirected Ethernet
Packets

Count—Number of ethernet packets redirected by the BWG.
Rate—Rate at which ethernet packets are redirected by the BWG.

[ oL-23900-01
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Field Description
Redirected Ethernet | ¢ Count—Number of ethernet bits redirected by the BWG.
Bits

Rate—Rate at which ethernet bits are redirected by the BWG.

Punted Data
Packets

Count—Number data packets punted from the cef path to the process path.

Rate—Rate at which packets are punted from the cef path to the process
path.

Dropped Packet Statistics

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5

The Dropped Packet Statistics pane shows:

Field

Description

Encapsulation
Errors Drops

Count—Number of data packets dropped due to encapsulation errors.

Rate—Rate at which data packets are dropped.

Invalid Address
Drops

Count—Number of data packets dropped due to invalid IP address.
Rate—Rate at which data packets are dropped.

Service Disabled
Drops

Count—Number of data packets dropped due to disabled service.

Rate—Rate at which data packets are dropped.

Invalid Protocol
Type Drops

Count—Number of data packets dropped due to invalid protocol types.
Rate—Rate at which data packets are dropped.

Length Error Drops

Count—Number of data packets dropped due to IP packet length errors.
Rate—Rate at which data packets are dropped.

Absent Key Drops

Count—Number of data packets dropped due to GRE key errors.
Rate—Rate at which data packets are dropped.

Flow Not Found
Drops

Count—Number of data packets dropped due to flow not found errors.

Rate—Rate at which data packets are dropped.

Flow Path Not
Found Drops

Count—Number of data packets dropped due to flow path not found errors.

Rate—Rate at which data packets are dropped due to flow path not found
erTors.

Flow Path Invalid
Source Drops

Count—Number of data packets dropped due to invalid source path address
errors in the GRE header.

Rate—Rate at which data packets are dropped due to invalid source path
address errors in the GRE header.

Session Not Found
Drops

Count—Number of data packets dropped due to session not found errors for
the GRE key.

Rate—Rate at which data packets are dropped due to session not found
erTors.

Subscriber Not
Found Drops

Count—Number of data packets dropped due to subscriber not found errors
for the GRE key.

Rate—Rate at which data packets are dropped due to subscriber not found
eITors.
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Field

Description

Checksum Error
Drops

Count—Number of data packets dropped due to checksum errors.

Rate—Rate at which data packets are dropped due to checksum errors.

Ingress Filtering
Drops

Count—Number of data packets dropped due to subscriber invalid source IP
address errors.

Rate—Rate at which data packets are dropped due to invalid source IP
address errors.

Sequence Number
Error Drops

Count—Number of data packets dropped due to sequence number errors.

Rate—Rate at which data packets are dropped due to sequence number
errors.

Fragmented Drops

Count—Number of data packets dropped due to fragmented packet errors.

Rate—Rate at which data packets dropped due to fragmented packet errors.

Static IP Host
Creation Failure
Drops

Count—Number of packets, such as upstream ARP and upstream data
packets, dropped due to failure in creation of Static IP Host.

Rate—Rate at which data packets are dropped due to failure in creation of
Static IP Host.

L2 Multicast and
Broadcast Drops

Number of L2 multicast and broadcast data packets other than ARP and
DHCP dropped by BWG.

Rate—Rate at which L2 multicast and broadcast data packets are dropped.

Throttled Path Punt
Drops

Count—Number of data packets dropped due to throttling of punts.
Rate—Rate at which L2 multicast and broadcast data packets are dropped.

Learned Static
Hosts Drops

Count—Number of data packets dropped due to BWG learning about static
hosts from upstream data packets.

Rate—Rate at which data packets are dropped due to BWG learning about
static hosts from upstream data packets.

The Profile Statistics pane shows:

Field

Description

Service Flow
Profile Not Found

Count—Number of service flow creation errors due to an unconfigured
service flow profile.

Rate—Rate at which creation errors are received.

QOS Profile Not
Found

Count—Number of service flow creation errors due to an unconfigured
service flow QoS profile.

Rate—Rate at which creation errors are received.

[ oL-23900-01
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Field Description
Classifier Profile e Count—Number of service flow creation errors due to an unconfigured
Not Found service flow packet classifier profile.

Rate—Rate at which service flow creation errors occur due to an
unconfigured service flow packet classifier profile.

SLA Profile Not
Found

Count—Number number of session creation failures due to configuration
error in Service Level Agreement (SLA) profile on BWG.

Rate—Rate at which session creation failures occur due to configuration
error in Service Level Agreement (SLA) profile on BWG.

Rejected Statistics

Paths

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5

Note

The Rejected Statistics pane shows:

Field

Description

Rejected Base
Station Paths

Count—Number of paths rejected because they exceeded the maximum
number of base stations allowed to connect to this BWG.

Rate—Rate at which paths are rejected because they exceeded the maximum
number of base stations allowed to connect to this BWG.

Unapproved Base
Station Sessions

Count—Number of session creation and/or session handoffs rejected
because the requesting base station is not approved for it.

Rate—Rate at which created sessions and/or session handoffs are rejected
because the base station is not approved for it.

Rejected
Subscriber Sessions

Count—Number of sessions rejected due to exceeding the maximum number
of allowed subscribers.

Rate—Rate at which sessions that were rejected due to exceeding the
maximum number of allowed subscribers.

Rejected Session
Flows

Count—Number of flows that were rejected due to exceeding the
maximum number of flows allowed per session.

Rate—Rate at which flows were rejected due to exceeding the maximum
number of flows allowed per session.

Session Deleted by
the Gateway

Count—Number of sessions deleted by the BWG.
Rate—Rate at which sessions were deleted by the BWG.

Rejected Hosts
Open Requests

Count—Number of hosts open requests rejected.

Rate—Rate at which hosts open requests are rejected.

For toolbar details, see Using the Toolbar, page 11-6.
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Note

Displaying BWG Real-Time Statistics

The Paths subtab shows information and statistics about each base station and contains:

Column

Description

Remote IP Address

Path IP address at the base station side.

Local IP Address

Path IP address at the BWG side.

Type Path type, can be signaling or data.
Sessions Number of sessions over the path.
Flows Number of flows over the path.

Sent IP Packets

Count—Total number of IP packets sent over the path.

Rate—Rate at which IP packets are sent.

Sent IP Bits

Count—Total number of IP bits sent over the path.

Rate—Rate at which IP bits are sent.

Received IP e Count—Total number of IP packets received over the path.
Packets e Rate—Rate at which IP packets are received.
Received IP Bits e Count—Total number of IP bits received over the path.

Rate—Rate at which IP bits are received.

Sent Ethernet
Packets

Count—Total number of Ethernet packets sent over the path.

Rate—Rate at which Ethernet packets are sent.

Sent Ethernet Bits

Count—Total number of Ethernet bits sent over the path.

Rate—Rate at which Ethernet bits are sent.

Received Ethernet
Packets

Count—Total number of Ethernet packets received over the path.

Rate—Rate at which Ethernet packets are received.

Received Ethernet
Bits

Count—Total number of Ethernet bits received over the path.

Rate—Rate at which Ethernet bits are received.

The User Groups subtab shows information and statistics for user groups and contains:

e Sessions and Flow Statistics, page 11-64

e Traffic Statistics, page 11-64

For toolbar details, see Using the Toolbar, page 11-6.

[ oL-23900-01
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Sessions and Flow Statistics

Traffic Statistics

The Sessions and Flow Statistics pane shows:

Column

Description

Name

Domain name identifying a user group.

Service Mode

User group service mode.

Current Session
Count

Total number of active sessions per user group.

Current Flows
Count

Total number of active flows per user group.

Sessions Created

Count—Total number of sessions created per user group.

Rate—Rate at which sessions are created.

Sessions Deleted

Count—Total number of sessions deleted per user group.

Rate—Rate at which sessions are deleted.

Flows Created

Count—Total number of flows created per user group.

Rate—Rate at which flows are created.

Flows Deleted

Count—Total number of flows deleted per user group.

Rate—Rate at which flows are deleted.

Group Overwrites

Count—Number of times this user group has been overwritten by the user
group received from the AAA server. Users can belong to a particular user
group at the time of initial entry and the AAA server can recategorize the
user under a different user group after successful authentication.

Rate—Rate at which this user group has been overwritten by the user group
received from the AAA server.

The Traffic Statistics pane shows:

Column

Description

Name

Domain name identifying a user group.

Service Mode

User group service mode.

Sent IP Packets

Count—Total number of IP packets sent over the path.

Rate—Rate at which IP packets are sent.

Sent IP Bits

Count—Total number of IP bits sent over the path.

Rate—Rate at which IP bits are sent.

Received IP
Packets

Count—Total number of IP packets received over the path.

Rate—Rate at which IP packets are received.

Received IP Bits

Count—Total number of IP bits received over the path.

Rate—Rate at which IP bits are received.

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Column Description
Sent Ethernet e Count—Total number of Ethernet packets sent over the path.
Packets

e Rate—Rate at which Ethernet packets are sent.

Sent Ethernet Bits e Count—Total number of Ethernet bits sent over the path.

e Rate—Rate at which Ethernet bits are sent.

Received Ethernet e Count—Total number of Ethernet packets received over the path.

Packets e Rate—Rate at which Ethernet packets are received.

Received Ethernet e Count—Total number of Ethernet bits received over the path.

Bits ¢ Rate—Rate at which Ethernet bits are received.
Invalid Source ¢ Count—Number of packets dropped due to invalid source address errors.
Packets

e Rate—Rate at which packets are dropped.

Invalid Source Bits | ¢ Count—Number of bits dropped due to invalid source address errors.

e Rate—Rate at which bits are dropped.

Displaying HA Real-Time Statistics

The MWTM enables you to display real-time statistics for Home Agent (HA) nodes in the MWTM web
interface. To display HA real-time statistics, select a HA node in the navigation tree and click the
Statistics tab. These subtabs appear:

e Global, page 11-65
e [P Local Pool Config, page 11-67
e [P Local Pool Stats, page 11-67

Global

The Global subtab shows global statistics for HA nodes and contains:
e Registrations Processed by AAA, page 11-66
e Registration Requests, page 11-66
e Standby Synchronization, page 11-67

~

Note  For toolbar details, see Using the Toolbar, page 11-6.
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Registrations Processed by AAA

The Registrations Processed by AAA pane shows:

Field

Description

Maximum
Processed in one
minute

The maximum number of registration requests processed in a minute by the HA.
It includes only those registration requests which were authenticated by the AAA
server.

Average time to
process (msecs)

The average time taken by the home agent to process a registration request.
Calculations are based on only those registration requests that were authenticated
by the AAA server.

Authenticated via
AAA Server

e Count—The total number of registration requests processed by the home
agent, including only those registration requests that were authenticated by
the AAA server.

e Rate—The total rate of registration requests processed by the home agent,
including only those registration requests that were authenticated by the
AAA server.

Registration Requests

The Registration Requests pane shows:

Field

Description

Current Bindings

e Count—The current number of entries in the home agent’s mobility binding
list. The home agent updates this number in response to registration events
from mobile nodes.

e Rate—The count can increment or decrease, resulting in a positive or
negative rate.

Initial Received

e Count—Total number of initial registration requests received by the HA.

e Rate—Rate at which initial registration requests are received by the HA.

Initial Denied

¢ Count—Total number of initial registration requests denied by the HA.

e Rate—Rate at which initial registration requests are denied by the HA.

All Received

e Count—Total number of all registration requests received by the HA.

e Rate—Rate at which all registration requests are received by the HA.

All Denied

¢ Count—Total number of all registration requests denied by the HA.

e Rate—Rate at which all registration requests are denied by the HA.
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The Standby Synchronization pane shows:

Field

Description

Binding Updates
Sent

e Count—Total number of binding updates sent by the home agent to a standby
home agent.

e Rate—Total rate of binding updates sent by the home agent to a standby
home agent.

Binding Updates
Unacknowledged

e Count—Total number of binding updates sent by the home agent for which
no acknowledgement is received from the standby home agent.

e Rate—Total rate of binding updates sent by the home agent for which no
acknowledgement is received from the standby home agent.

IP Local Pool Config

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Config subtab shows IP addresses for HA nodes and contains:

Column

Description

Name

Name that uniquely identifies an IP local pool. This name must be unique among
all the local IP pools even when they belong to different pool groups.

Addresses: Low

This object specifies the first IP address of the range of IP addresses contained
by this pool entry. This address must be less than or equal to the High address.

Addresses: High

This object specifies the last IP address of the range of IP addresses mapped by
this pool entry. If only a single address is being mapped, the value of this object
is equal to the Low value.

Addresses: Free

Number of IP addresses available for use in the range of IP addresses.

Addresses: In Use

Number of IP addresses being used in the range of IP addresses.

Priority

This object specifies the priority of the IP local pool. IP local pools will be used
in assigning IP addresses in the order of priority.

IP Local Pool Stats

~

Note

For toolbar details, see Using the Toolbar, page 11-6.
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The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for HA nodes and contains:

Column

Description

Name

Name that uniquely identifies an IP local pool. This name must be unique among
all the local IP pools even when they belong to different pool groups.

Addresses: Free

Number of IP addresses available for use in this IP local pool.

Addresses: In Use

Number of IP addresses being used in this IP local pool.

Addresses:
Maximum In Use

Contains the high water mark of used addresses in an IP local pool since pool
creation, since the system was restarted, or since this object was reset, whichever
occurred last.

Addresses In Use:
Low Threshold

When the number of used addresses in an IP local pool falls below this threshold
value, a notification is generated.

Addresses In Use:
High Threshold

When the number of used addresses in an IP local pool is equal or exceeds this
threshold value, a notification is generated.

Addresses In Use:
Low Threshold
Percentage

When the percentage of used addresses in an IP local pool falls below this
threshold value, a notification is generated.

Addresses In Use:
High Threshold
Percentage

When the percentage of used addresses in an IP local pool is equal or exceeds
this threshold value, a notification is generated.

Displaying GGSN Real-Time Statistics

The MWTM enables you to display real-time statistics only in the MWTM web interface for Gateway
GPRS Support Nodes (GGSNs) that reside on the Service and Application Module for IP (SAMI). To

display GGSN real-time statistics, select a SAMI-based GGSN node in the navigation tree and click the
Statistics tab. These subtabs appear:

e Global, page 11-68
e SGSN Throughput, page 11-74

e APN, page 11-75

e [P Local Pool Config, page 11-79
e [P Local Pool Stats, page 11-80

Global
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

The Global subtab shows global statistics for GGSN nodes and contains:
e GTP Statistics, page 11-69

¢ Charging Statistics, page 11-69

e GTP Throughput Statistics Ext, page 11-70
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e PDP Context Statistics, page 11-71
e AAA Authentication Statistics, page 11-73
e AAA Accounting Statistics, page 11-73
e [P and UDP Statistics, page 11-74
GTP Statistics
The GTP Statistics pane displays statistics about the GPRS Tunneling Protocol (GTP) and contains:
Field Description
GTP Signaling GTP signaling messages sent between the Serving GPRS Support Node (SGSN)
Messages and GGSN.
G-PDU Messages |GTP Packet Data Unit (G-PDU) messages sent or received on an SGSN path.
G-PDU Octets G-PDU bits sent or received in a GTP PDU message on an SGSN path.
Unexpected GTP Number of unexpected GTP signaling messages sent or received.
Signaling Messages
GTP Messages with |[Number of GTP messages received with wrong value.
Parser Errors
Sent ¢ Count—Number of messages or bits in the transmit direction.
e Rate—The transmit rate of the messages or bits.
Received e Count—Number of messages or bits in the receive direction.
e Rate—The receive rate of the messages or bits.
Charging Statistics
The Charging Statistics pane displays count and rate statistics for GGSN charging messages and
contains:
Field Description
Current Open ¢ Count—The number of currently opened G-CDRs on the GGSN.
CDRs e Rate—Rate of currently opened G-CDRs on the GGSN.
Current Closed e Count—The number of currently closed G-CDRs on the GGSN which have
CDRs not been sent to the CG.
e Rate—Rate of currently closed G-CDRs on the GGSN which have not been
sent to the CG.
Current Containers | ¢ Count—The number of currently open or closed charging containers.
e Rate—Rate of currently open or closed charging containers.
CDR Messages e Count—The number of currently pending G-CDR output messages.
Pending e Rate—Rate of currently pending G-CDR output messages.
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Field Description
CDR Messages e Count—The number of transmitted G-CDR output messages since the
Sent charging service is enabled.

e Rate—Rate of transmitted G-CDR output messages since the charging
service is enabled.

CDRs Opened

¢ Count—Total number of CDRs opened on the GGSN either since system
startup or since the last time the charging statistics was cleared.

e Rate—Rate of CDRs opened on the GGSN either since system startup or
since the last time the charging statistics was cleared.

Containers Created

e Count—Total number of containers created on the GGSN either since system
startup or since the last time the charging statistics was cleared.

e Rate—Rate of containers created on the GGSN either since system startup
or since the last time the charging statistics was cleared.

Service Records
Created

e Count—Total number of service records created on the GGSN either since
the system startup or since the time the service aware feature is enabled.

e Rate—Rate of service records created on the GGSN either since the system
startup or since the time the service aware feature is enabled.

Total Unique APNs

¢ Count—The number of access points for which charging data is being
collected.

e Rate—Rate of access points for which charging data is being collected.

Charging Gateway
Down Times

e Count—The number of occurrences of cgprsCgAlarmEchoFailure traps state
transitions since system startup.

e Rate—Rate of occurrences of cgprsCgAlarmEchoFailure traps state
transitions since system startup.

GTP Throughput Statistics Ext
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The GTP Throughput Statistics Ext pane displays count and rate statistics about GTP throughput and

contains:

Field Description

GTP Packets GTP packets between the GGSN and SGSN.
GTP Bytes GTP bytes between the GGSN and SGSN.

Sampling Interval
in Minutes: 3

Global GTP throughput statistics on the GGSN for a duration of 3 minutes.

Sampling Interval
in Minutes: 5

Global GTP throughput statistics on the GGSN for a duration of 5 minutes.

Data age (minutes)

The difference in minutes between the time when the data was collected and
retrieved. This is the time that has elapsed after the previous collection or update
of the data.

Upstream

Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream

Rate (per second) of downstream GTP traffic during the last sampling period.
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The PDP Context Statistics pane shows count and rate values for these statistics:

Field

Description

Active GTP v0O PDP Contexts

Count—PDP contexts (GTP version 0) that are active.

Rate—The rate of active PDP contexts (GTP version 0).

Active GTP v1 PDP Contexts

Count—PDP contexts (GTP version 1) that are active.

Rate—The rate of active PDP contexts (GTP version 1).

PDP Contexts Created

Count—PDP contexts that were created.

Rate—Rate of PDP contexts that were created.

PDP Contexts Deleted

Count—PDP contexts that were deleted.
Rate—Rate of PDP contexts that were deleted.

PDP Context Activations
Rejected

Count—PDP contexts for which the activation request was rejected.

Rate—Rate of PDP contexts for which the activation request was rejected.

PDP PPP-Regen Interfaces
Created

Count—Device-specific interfaces created for association with PDP contexts
regenerated to a PPP session.

Rate—Rate of device-specific interfaces created for association with PDP contexts
regenerated to a PPP session.

Active PDP Contexts with
Direct Tunnel

Count—Active PDP contexts with direct tunnel enabled.

Rate—Rate of active PDP contexts with direct tunnel enabled.

PDP Contexts Deleted Without
Waiting for the SGSN

Count—PDPs deleted in the GGSN without waiting for a delete context response from
the SGSN.

Rate—Rate of PDPs deleted in the GGSN without waiting for a delete context response
from the SGSN.

PDP Contexts Deleted Without
Sending to the SGSN

Count—PDPs deleted in the GGSN without sending a delete request to the SGSN.
Rate—Rate of PDPs deleted in the GGSN without sending a delete request to the SGSN.

Update PDP Context Requests
Sent

Count—Update PDP context requests that the GGSN initiated and that were sent to the
SGSN.

Rate—Rate of update PDP context requests that the GGSN initiated and that were sent
to the SGSN.

Update PDP Context
Responses Received

Count—Update PDP context responses received from the SGSN for the GGSN-initiated
update requests.

Rate—Rate of update PDP context responses received from the SGSN for the
GGSN-initiated update requests.

COA Messages Received

Count—Change of Authorization (COA) messages received at the GGSN.
Rate—Rate of COA messages received at the GGSN.

COA Messages Dropped

Count—COA messages dropped at the GGSN.
Rate—Rate of COA messages dropped at the GGSN.

[ oL-23900-01
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Field

Description

COA QOS Updates Sent

Count—Update PDP requests for QOS changes that COA initiated and that are sent
from the GGSN.

Rate—Rate of update PDP requests for QOS changes that COA initiated and that are
sent from the GGSN.

Error Indication Messages
Received

Count—Number of error indication messages received on the GGSN.

Rate—Rate of error indication messages received on the GGSN.

Direct Tunnels Enabled

Count—Direct tunnels enabled for the PDP contexts in the GGSN.
Rate—Rate of direct tunnels enabled for the PDP contexts in the GGSN.

Error Indications for DT PDP
Contexts

Count—Error indications received for Direct Tunnel (DT) PDP contexts from the Radio
Network Controller (RNC).

Rate—Rate of error indications received for Direct Tunnel (DT) PDP contexts from the
Radio Network Controller (RNC).

DT PDP Contexts Deleted Due
to Update Response

Count—Direct tunnel PDP contexts deleted because of update response failure.

Rate—Rate of direct tunnel PDP contexts deleted because of update response failure.

PDP Context Activations
Failure Ratio

Count—Number of PDP context activation failures.

Rate—Rate of PDP context activation failures.

PDP Context Requests
Rejected due to Insufficient
Resources

Count—Number of PDP context requests rejected due to insufficient resources.

Rate—Rate of PDP context requests rejected due to insufficient resources.

PDP Context Requests
Rejected due to Insufficient
Resources for PPP
Regeneration

Count—Number of PDP context Requests rejected due to insufficient resources for PPP
regeneration.

Rate—Rate of PDP context requests rejected due to insufficient resources for PPP
regeneration.

PDP Context Requests
Dropped due to the PPP
Regeneration Threshold Limit

Count—Number of PDP context requests dropped due to the PPP regeneration
threshold limit.

Rate—Rate of PDP context requests dropped due to the PPP regeneration threshold
limit.

PDP Context Messages with
TFT Semantic Errors

Count—Number of PDP context messages with TFT semantic errors.

Rate—Rate of PDP context messages with TFT semantic errors.

PDP Context Messages with
TFT Syntax Errors

Count—Number of PDP context messages with TFT syntax errors.

Rate—Rate of PDP context messages with TFT syntax errors.

PDP Context Messages with
Packet Filter Syntax Errors

Count—Number of PDP context messages with packet filter syntax errors.

Rate—Rate of PDP context messages with packet filter syntax errors.

PDP Context Messages with
Packet Filter Semantic Errors

Count—Number of PDP context messages with packet filter semantic errors.

Rate—Rate of PDP context messages with packet filter semantic errors.

Error indication Messages Sent

Count—Number of error indication messages sent.

Rate—Rate at which the error indication messages are sent.

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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AAA Authentication Statistics

AAA Authentication Statistics pane shows:

Field

Description

Server Name

Name of the server.

Server State

Whether the server is up (operational) or down (not operational).

Transactions ¢ Count—Number of authentication transactions with the server which succeeded since it is made active.

Completed e Rate—Rate at which the authentication transactions with the server are succeeded since it is made
active.

Transaction ¢ Count—Number of authentication transactions with this server which failed since it is made active.

Failures e Rate—Rate at which the authentication transactions with the server are failed since it is made
active.

Requests ¢ Count—Number of authentication requests sent to this server since it is made active.

e Rate—Rate at which the authentication requests are sent to the server since it is made active.

Request Timeouts

¢ Count—Number of authentication requests which are timed out since it is made active.

e Rate—Rate at which the authentication requests are timed out since it is made active.

Error Responses

e Count—Number of server ERROR authentication responses received from this server since it is made
active.

e Rate—Rate at which the server ERROR authentication responses are received from the server since it
is made active.

Incorrect
Responses

e Count—Number of authentication responses which could not be processed since it is made active.

e Rate—Rate (per second) of authentication responses which could not be processed since it is made
active.

AAA Accounting Statistics

AAA Accounting Statistics pane shows:

Field

Description

Server Name

Name of the server.

Server State

Whether the server is up (operational) or down (not operational).

Transactions e Count—Number of accounting transactions with the server which succeeded since system
Completed reinitialization.

e Rate—Rate at which the accounting transactions with the server are succeeded since it is made

active.

Transaction e Count—Number of accounting transactions with this server which failed since system reinitialization.
Failures e Rate—Rate at which the accounting transactions with the server are failed since it is made active.
Requests e Count—Number of accounting requests sent to this server since system reinitialization.

e Rate—Rate at which the accounting requests are sent to the server since it is made active.
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Field

Description

Request Timeouts

e Count—Number of accounting requests which have timed out since system reinitialization.

e Rate—Rate at which the accounting requests are timed out since it is made active.

Error Responses

e Count—Number of server ERROR accounting responses received from this server since system

reinitialization.

¢ Rate—Rate at which the server ERROR accounting responses are received from the server since it is

made active.

Incorrect
Responses

e Count—Number of accounting responses which could not be processed since system reinitialization.

e Rate—Rate of accounting responses which could not be processed since system reinitialization.

IP and UDP Statistics

The IP and UDP Statistics pane shows:

Field

Description

IP In Header Errors

Input datagrams discarded because of errors in their IP headers, including bad
checksums, version number mismatches, other format errors, time-to-live
exceeded, and errors discovered in processing their IP options.

IP Out Discards

Outbound packets that were discarded although no errors were detected. One
reason for discarding a packet would be to free buffer space.

IP Out No Routes

IP datagrams discarded because no route could be found to transmit them. This
statistic includes any datagrams that a host cannot route because all its default
gateways are down.

IP Reassembly Failures detected by the IP reassembly algorithm.

Fails

IP Routing Routing entries that were discarded even though they are valid. One reason for
Discards discarding a routing entry would be to free buffer space for other routing entries.

UDP In Datagrams

UDP datagrams delivered to UDP users.

SGSN Throughput

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

The SGSN Throughput subtab shows:

Field

Description

SGSN Name

Name of the SGSN.

Sampling Interval
in Minutes: 3

Throughput statistics on the SGSN for a duration of 3 minutes.

Sampling Interval
in Minutes: 5

Throughput statistics on the SGSN for a duration of 5 minutes.
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Field

Description

Upstream Packets

Rate (per second) of upstream packets sent on this SGSN during the last sampling
period.

Upstream Bytes

Rate (per second) of upstream bytes sent on this SGSN during the last sampling
period.

Downstream
Packets

Rate (per second) of downstream packets sent on this SGSN during the last
sampling period.

Downstream Bytes

Rate (per second) of downstream bytes sent on this SGSN during the last
sampling period.

Data age (minutes)

The difference in minutes between the time when the data was collected and
retrieved. This is the time that has elapsed after the previous collection or update
of the data.

For toolbar details, see Using the Toolbar, page 11-6.

The APN subtab contains:

e APN Instance Throughput, page 11-75

e APN Instance Throughput Ext, page 11-76
e APN Instance PDP, page 11-76
e APN Instance PDP Ext, page 11-77

e APN Instance Miscellaneous, page 11-78

APN Instance Throughput

To view the APN Instance Throughput Statistics table, choose this option from the Type drop-down
menu. The GUI displays the count and rate values for these statistics:

Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Upstream Bits

e Count—Number of upstream bits sent on this APN during the last sampling period.

e Rate—Rate (per second) of upstream bits sent on this APN during the last sampling period.

Downstream Bits

¢ Count—Number of downstream bits sent on this APN during the last sampling period.

e Rate—Rate (per second) of downstream bits sent on this APN during the last sampling period.
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Field

Description

Upstream Packets

e Count—Number of upstream packets sent on this APN during the last sampling period.

e Rate—Rate (per second) of upstream packets sent on this APN during the last sampling period.

Downstream Packets

e Count—Number of downstream packets sent on this APN during the last sampling period.

e Rate—Rate (per second) of downstream packets sent on this APN during the last sampling
period.

APN Instance Throughput Ext

To view the APN Instance Throughput Ext Statistics table, choose this option from the Type drop-down
menu. The GUI displays the count and rate values for these statistics:

Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Sampling Interval in
Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes.

Sampling Interval in
Minutes: 5

Throughput statistics on the APN for a duration of Sminutes.

Upstream Packets

Rate (per second) of upstream packets sent on this APN during the last sampling period.

Upstream Bits

Rate (per second) of upstream bytes sent on this APN during the last sampling period.

Downstream Packets

Rate (per second) of downstream packets sent on this APN during the last sampling period.

Downstream Bytes

Rate (per second) of downstream bytes sent on this APN during the last sampling period.

Data Age (minutes)

The difference in minutes between the time when the data was collected and retrieved. This is the
time that has elapsed after the previous collection or update of the data.

APN Instance PDP

To view the APN Instance PDP Statistics table, choose this option from the Type drop-down menu. The
GUI displays the count and rate values for these statistics:

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Active PDP/Bearers e Count—Current number of active PDP/Bearer contexts on this APN.

PDP/Bearer Activations by MS Success | ® Count—Total number of successfully completed PDP/Bearer context activation
procedures by the MS on this APN.

e Rate—Rate (per second) of successfully completed PDP/Bearer context
activation procedures by the MS on this APN.

e Ratio—Number of successful activations for every 100 activation attempts.
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Field

Description

PDP/Bearer Activations by MS Failure

Count—Total number of failed PDP/Bearer context activation procedures by the
MS on this APN.

Rate—Rate (per second) of failed PDP/Bearer context activation procedures by
the MS on this APN.

PDP/Bearer Deactivations by Network
Success

Count—Total number of successfully completed PDP/Bearer context
deactivation procedures by the GGSN on this APN.

Rate—Rate (per second) of successfully completed PDP/Bearer context
deactivation procedures by the GGSN on this APN.

PDP/Bearer Deactivations by Network
Failure

Count—Total number of failed PDP/Bearer context deactivation procedures by
the GGSN on this APN.

Rate—Rate (per second) of failed PDP/Bearer context deactivation procedures
by the GGSN on this APN.

PDP/Bearer Deactivations by Network
PDP/Bearer Retainability

Ratio—For every 100 PDP/Bearer contexts, the number of activations whose
deactivation was not completed by the GGSN.

PDP/Bearer Deactivations By MS
Success

Count—Total number of successfully completed PDP/Bearer context
deactivation procedures by the MS on this APN.

Rate—Rate (per second) of successfully completed PDP/Bearer context
deactivation procedures by the MS on this APN.

Ratio—Number of successful deactivations for every 100 deactivation attempts.

PDP/Bearer Deactivations By MS
Failure

Count—Total number of failed PDP/Bearer context deactivation procedures by
the MS on this APN.

Rate—Rate (per second) of failed PDP/Bearer context deactivation procedures by
the MS on this APN.

APN Instance PDP Ext

To view the APN Instance PDP Ext Statistics table, choose this option from the Type drop-down menu.
The GUI displays the count and rate values for these statistics:

Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Dynamic PDP/Bearer Activations By
MS Success

Count—Total number of successfully completed dynamic PDP/Bearer context
activation procedures initiated by MS on this APN.

Rate—Rate (per second) of successfully completed dynamic PDP/Bearer
context activation procedures initiated by MS on this APN.

Ratio—Number of successful dynamic activations for every 100 dynamic
activation attempts.

Dynamic PDP/Bearer Activations By
MS Failure

Count—Total number of failed dynamic PDP/Bearer context activation
procedures initiated by MS on this APN.

Rate—Rate (per second) of failed dynamic PDP/Bearer context activation
procedures initiated by MS on this APN.
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Field Description
PDP/Bearer Activations By Network ¢ Count—Total number of successfully completed network initiated PDP/Bearer
Success context activation procedures.

e Rate—Rate (per second) of successfully completed network initiated
PDP/Bearer context activation procedures.

e Ratio—Number of successful network initiated activations for every 100
activation attempts.

PDP/Bearer Activations By Network ¢ Count—Total number of failed network initiated PDP/Bearer context activation
Failure procedures.

e Rate—Rate (per second) of failed network initiated PDP/Bearer context
activation procedures.

PDP/Bearer Updates By Network ¢ Count—Total number of successful update responses received from the SGSN for
Success GGSN initiated update requests on this APN.

e Rate—Rate (per second) of successful update responses received from the SGSN
for GGSN initiated update requests on this APN.

e Ratio—Number of successful update responses received for every 100 update
attempts.

PDP/Bearer Updates By Network Failure | ® Count—Total number of failed update responses received from the SGSN for
GGSN initiated update requests on this APN.

e Rate—Rate (per second) of failed update responses received from the SGSN for
GGSN initiated update requests on this APN.

APN Instance Miscellaneous

To view the APN Instance Miscellaneous Statistics table, choose this option from the Type drop-down
menu. The GUI displays count and rate values for these statistics:

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

DHCP Requests ¢ Count—Total number of successful DHCP address request sent by the GGSN
Success or PDNGW on this APN.

e Rate—Rate at which the successful DHCP address requests are sent by the
GGSN or PDNGW on this APN.

e Ratio—Number of successful DHCP requests for every 100 DHCP requests.

DHCP Requests ¢ Count—Total number of unsuccessful DHCP address request sent by the GGSN
Failure or PDNGW on this APN.

e Rate—Rate at which the unsuccessful DHCP address requests are sent by the
GGSN or PDNGW on this APN.

DHCP Releases ¢ Count—Total number of DHCP address release request sent by the GGSN or
PDNGW on this APN.

e Rate—Rate at which the DHCP address release request is sent by the GGSN
or PDNGW on this APN.
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Field Description
COA Message e Count—Number of successfully acknowledged COA messages by the GGSN or
Success PDNGW with a COA ACK.
e Rate—Rate of successfully acknowledged COA messages by the GGSN or
PDNGW with a COA ACK.
e Ratio—Number of successfully acknowledged COA messages for every 100
COA messages received on this APN.
COA Message ¢ Count—Number of unsuccessfully acknowledged COA messages by the GGSN
Failure or PDNGW with a COA ACK.

Rate—Rate of unsuccessfully acknowledged COA messages by the GGSN or
PDNGW with a COA ACK.

Direct Tunnels
Enabled

Count—Direct tunnels enabled for the PDP contexts on this APN.

Rate—Rate at which the direct tunnels are enabled for the PDP contexts on
this APN.

IP Local Pool Config

S

Note

For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Config subtab shows IP addresses for GGSN, PDNGW, or SGW nodes and contains:

Field Description
Name Name of the IP local pool.
Addresses e Low—The first IP address of the range of IP addresses contained by this pool

entry.

High—The last IP address of the range of IP addresses mapped by this pool
entry.

Free—Number of IP addresses available for use within the range of IP
addresses.

In Use—Number of IP addresses being used within the range of IP
addresses.
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IP Local Pool Stats
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

The IP Local Pool Stats subtab shows IP addresses and IP addresses in use for GGSN, PDNGW, or SGW
nodes and contains:

Field Description
Name Name of the IP local pool.
Addresses e Free—Number of IP addresses available for use in this IP local pool.

¢ In Use—Number of IP addresses being used in this IP local pool.

e Maximum in Use—The maximum number of used addresses in an IP local
pool since pool creation, since the system was restarted, or since this object
was reset, whichever occurred last.

Displaying PDSN Real-Time Statistics

The MWTM enables you to display real-time statistics for Packet Data Serving Node (PDSN) nodes in
the MWTM web interface. To display PDSN real-time statistics, select a PDSN node in the navigation
tree and click the Statistics tab. The following option appears under Type drop-down menu:

e System Statistics, page 11-80
System Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.
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To view the System Statistics, choose this option from Type drop-down menu. The GUI displays the

following categories:

e Session Statistics, page 11-81

¢ Flow Statistics, page 11-82

e Session Bandwidth Statistics, page 11-83

e PCF Statistics, page 11-83

e Traffic Statistics, page 11-84

Session Statistics

The Session Statistics pane contains:

Field

Description

Maximum Allowed
Sessions

Count—Maximum number of sessions allowed by the system.

Session Failure
Ratio

Count—Ratio of session failures.

Session Utilization

Count—Total session utilization.

Total Active
Sessions

Count—Total number of sessions in active state.

Total Dormant
Sessions

Count—Total number of sessions in dormant state.

Total HDLC over
GRE Sessions

Count—Total number of HDLCoGRE sessions currently established with the
system.

Total PPP over
GRE Sessions

Count—Total number of PPPoGRE sessions currently established with the system.

Total Session
Failures

Count—Number of A10/A11 session failures occurring since PDSN agent restarted.

Total Sessions

Count—Total number of sessions currently established with the system.

Total Sessions
Established

Count—Total number of sessions established since system was last restarted.

Total Sessions
Established Rate

Count—Rate at which the sessions were established since system was last
restarted.

Total Sessions
Release

Count—Total number of sessions released since system was last restarted.

Total Sessions
Released Rate

Count—Rate at which the sessions were released since system was last restarted.
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Flow Statistics

The Flow Statistics pane contains:

Field

Description

Flow Failure Ratio

Count—Ratio of flow failures.

Total Mobile IP
Flow Failures

Count—Total number of mobile IP flow setup request failed since system
reboot.

Rate—Rate of mobile IP flow setup request failed since system reboot.

Total Mobile IP
Flows

Count—Total number of flows currently using MolP services.

Total Mobile IP
Flows Established

Count—Total number of mobile IP flow that has been established successfully
since system reboot.

Rate—Rate of mobile IP flow that has been established successfully since
system reboot.

Total MSID Flows

Count—Total number of flows currently using MSID service.

Total Proxy Mobile
IP Flow Failures

Count—Total number of proxy mobile IP flow setup request failed since system
reboot.

Rate—Rate of proxy mobile IP flow setup request failed since system reboot.

Total Proxy Mobile | ¢ Count—Total number of flows currently using proxy MolP service.

IP Flows

Total Proxy Mobile | ¢ Count—Total number of proxy mobile IP flow that has been established
IP Flows successfully since system reboot.

Established

Rate—Rate of proxy mobile IP flow that has been established successfully
since system reboot.

Total Simple IP
Flow Failures

Count—Total number of simple IP flow setup request failed since last system
reboot.

Rate—Rate of simple IP flow setup request failed since last system reboot.

Total Simple IP
Flows

Count—Total number of flows currently using simple IP service.

Total Simple IP
Flows Established

Count—Total number of Simple IP flow that has been established successfully
since system reboot.

Rate—Rate of Simple IP flow that has been established successfully since
system reboot.

Total Unknown
Type Flow Failures

Count—Total number of unknown type flow setup request failed since last
system reboot.

Rate—Rate of unknown type flow setup request failed since last system reboot.

Total VPDN Flow
Failures

Count—Total number of VPDN flow setup request failed since last system
reboot.

Rate—Rate of VPDN flow setup request failed since last system reboot.
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Field

Description

Total VPDN Flows

¢ Count—The total number of flows currently using VPDN service.

Total VPDN Flows
Established

¢ Count—Total number of VPDN flow that has been established successfully
since system reboot.

e Rate—Rate of VPDN flow that has been established successfully since system
reboot.

Session Bandwidth Statistics

The Session Bandwidth Statistics pane contains:

Field Description

Bandwidth Count—Total bandwidth that has been utilized.

Utilization

Total Allocated Count—Total bandwidth allocated for sessions currently established on the PDSN.
Bandwidth

Total Available Count—Bandwidth available on the PDSN system for creation of new sessions.
Bandwidth

Total Configured

Count—total bandwidth value configured via the CLI that would be supported by

Bandwidth PDSN system.
PCF Statistics
The PCF Statistics pane contains:
Field Description
Maximum Allowed |Count—Maximum number of PCF allowed by the system.
PCFs
PCF Utilization Count—Total PCF utilization.
Total PCFs Count—Total number of PCF currently interacting with the system.
User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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The Traffic Statistics pane contains:

Field

Description

Proxy Mobile IP
Packets Received

Count—Total number of proxy mobile IP data packets received from mobile
stations by PDSN since system was last restarted.

Rate—Rate at which the proxy mobile IP data packets are received from mobile
stations by PDSN since system was last restarted.

Short Data Burst
Packets Sent

Count—Total number of SDB marked data packets sent to PCF from PDSN
since system was last restarted.

Rate—Rate at which the SDB marked data packets are sent to PCF from PDSN
since system was last restarted.

Simple IP Packets
Sent

Count—Total number of simple IP data packets sent to mobile stations since
system was last restarted.

Rate—Rate at which the simple IP data packets are sent to mobile stations since
system was last restarted.

Mobile IP Packets
Sent

Count—Total number of mobile IP data packets sent to mobile stations from
PDSN since system was last restarted.

Rate—Rate at which the mobile IP data packets are sent to mobile stations from
PDSN since system was last restarted.

No Session Packet
Discards

Count—Total number of packets discarded from PCF because of missing
session since system was last restarted.

Rate—Rate at which the packets are discarded from PCF because of missing
session since system was last restarted.

Proxy Mobile IP
Packets Sent

Count—Total number of proxy mobile IP data packets sent to mobile stations
from PDSN since system was last restarted.

Rate—Rate at which the proxy mobile IP data packets are sent to mobile
stations from PDSN since system was last restarted.

Invalid GRE
Protocol Packet
Discards

Count—Total number of packets discarded from PCF because of invalid GRE
protocol since system was last restarted.

Rate—Rate at which the packets are discarded from PCF because of invalid
GRE protocol since system was last restarted.

Mobile IP Packets
Received

Count—Total number of mobile IP data packets received from mobile stations
since system was last restarted.

Rate—Rate at which the mobile IP data packets are received from mobile
stations since system was last restarted.

Simple IP Bits Sent

Count—Total number of simple IP data octets (in unit of 1024 octets) sent to
mobile stations from PDSN since system was last restarted.

Rate—Rate at which the simple IP data octets (in unit of 1024 octets) are sent
to mobile stations from PDSN since system was last restarted.
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Field Description
Mobile IP Bits ¢ Count—Total number of mobile IP data octets (in unit of 1024 octets) received
Received from mobile stations by PDSN since system was last restarted.

Rate—Rate at which the mobile IP data octets (in unit of 1024 octets) are
received from mobile stations by PDSN since system was last restarted.

Short Data Burst
Bits Sent

Count—Total number of SDB marked data octets sent to PCF from PDSN since
system was last restarted.

Rate—Rate at which the SDB marked data octets are sent to PCF from PDSN
since system was last restarted.

Proxy Mobile IP
Bits Sent

Count—Total number of proxy mobile IP data octets (in unit of 1024 octets) sent
to mobile stations from PDSN since system was last restarted.

Rate—Rate at which the proxy mobile IP data octets (in unit of 1024 octets) are
sent to mobile stations from PDSN since system was last restarted.

Mobile IP Bits Sent

Count—Total number of mobile IP data octets (in unit of 1024 octets) sent to
mobile stations from PDSN since system was last restarted.

Rate—Rate at which the mobile IP data octets (in unit of 1024 octets) are sent
to mobile stations from PDSN since system was last restarted.

Proxy Mobile IP
Bits Received

Count—Total number of proxy mobile IP data octets (in unit of 1024 octets)
received from mobile stations since system was last restarted.

Rate—Rate at which the proxy mobile IP data octets (in unit of 1024 octets) are
received from mobile stations since system was last restarted.

Simple IP Bits

Count—Total number of simple IP data octets (in unit of 1024 octets) received

Received from mobile stations by PDSN since system was last restarted.
e Rate—Rate at which the simple IP data octets (in unit of 1024 octets) are
received from mobile stations by PDSN since system was last restarted.
No GRE Key e Count—Total number of packets discarded from PCF because of the missing

Packet Discards

GRE Keying since system was last restarted.

Rate—Rate at which the packets are discarded from PCF because of the missing
GRE Key since system was last restarted.

Invalid Checksum
Packet Discards

Count—Total number of packets discarded from PCF because of invalid
checksum since system was last restarted.

Rate—Rate at which the packets are discarded from PCF because of invalid
checksum since system was last restarted.

Simple IP Packets
Received

Count—Total number of simple IP data packets received from mobile stations
since system was last restarted.

Rate—Rate at which the simple IP data packets are received from mobile
stations since system was last restarted.
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Displaying SGW Real-Time Statistics

The MWTM enables you to display real-time statistics for SGW nodes in the MWTM web interface. To
display real-time statistics, select the node in the navigation tree and click the Statistics tab. These
options appear under the Type drop down list:

e AAA, page 11-86

e APN Instance Throughput, page 11-88

e APN Instance Throughput Ext, page 11-88
e APN Instance Bearer, page 11-89

e EPC Buffering, page 11-90

e EPC Overload Protection, page 11-91

e GTP Statistics, page 11-93

e GTPv2 Statistics, page 11-96

e GTPv2 Path Bearer Statistics, page 11-97
e GTPv2 Path Session Statistics, page 11-98
e GTP Path Error Statistics, page 11-99

e [P Local Pool Configuration, page 11-99

e [P Local Pool Statistics, page 11-99

AAA
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the AAA statistics table, choose this option from the Type drop-down menu. The GUI displays
the following categories:

¢ AAA Authentication Statistics, page 11-86
e AAA Accounting Statistics, page 11-87

AAA Authentication Statistics

AAA Authentication Statistics pane shows:

Column Description

Server Name Name of the server.

Server State Whether the server is up (operational) or down (not operational).

Transactions e Count—Number of authentication transactions with the server which succeeded since it is made active.

Completed e Rate—Rate at which the authentication transactions with the server are succeeded since it is made
active.
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Column Description

Transaction e Count—Number of authentication transactions with this server which failed since it is made active.

Failures e Rate—Rate at which the authentication transactions with the server are failed since it is made
active.

Requests ¢ Count—Number of authentication requests sent to this server since it is made active.

e Rate—Rate at which the authentication requests are sent to the server since it is made active.

Request Timeouts

e Count—Number of authentication requests which are timed out since it is made active.

e Rate—Rate at which the authentication requests are timed out since it is made active.

Error Responses

e Count—Number of server ERROR authentication responses received from this server since it is made
active.

e Rate—Rate at which the server ERROR authentication responses are received from the server since it
is made active.

Incorrect
Responses

¢ Count—Number of authentication responses which could not be processed since it is made active.

e Rate—Rate of authentication responses which could not be processed since it is made active.

AAA Accounting Statistics

AAA Accounting Statistics pane shows:

Column

Description

Server Name

Name of the server.

Server State

Whether the server is up (operational) or down (not operational).

Transactions ¢ Count—Number of accounting transactions with the server which succeeded since system
Completed reinitialization.
e Rate—Rate at which the accounting transactions with the server are succeeded since it is made
active.
Transaction ¢ Count—Number of accounting transactions with this server which failed since system reinitialization.
Failures e Rate—Rate at which the accounting transactions with the server are failed since it is made active.
Requests e Count—Number of accounting requests sent to this server since system reinitialization.

e Rate—Rate at which the accounting requests are sent to the server since it is made active.

Request Timeouts

e Count—Number of accounting requests which have timed out since system reinitialization.

e Rate—Rate at which the accounting requests are timed out since it is made active.

Error Responses

e Count—Number of server ERROR accounting responses received from this server since system
reinitialization.

e Rate—Rate at which the server ERROR accounting responses are received from the server since it is
made active.

Incorrect ¢ Count—Number of accounting responses which could not be processed since system reinitialization.
Responses e Rate—Rate of accounting responses which could not be processed since system reinitialization.
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APN Instance Throughput
~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Throughput Statistics table, choose this option from the Type drop-down
menu. The GUI displays the count and rate values for these statistics:

Column Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Upstream Bits

e Count—Number of upstream bits sent on this APN during the last sampling period.

e Rate—Rate (per second) of upstream bits sent on this APN during the last sampling period.

Downstream Bits

e Count—Number of downstream bits sent on this APN during the last sampling period.

e Rate—Rate (per second) of downstream bits sent on this APN during the last sampling period.

Upstream Packets

¢ Count—Number of upstream packets sent on this APN during the last sampling period.

e Rate—Rate (per second) of upstream packets sent on this APN during the last sampling period.

Downstream Packets

e Count—Number of downstream packets sent on this APN during the last sampling period.

e Rate—Rate (per second) of downstream packets sent on this APN during the last sampling
period.

APN Instance Throughput Ext
~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Throughput Ext Statistics table, choose this option from the Type drop-down
menu. The GUI displays:

Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Sampling Interval in
Minutes: 3

Throughput statistics on the APN for a duration of 3 minutes.

Sampling Interval in
Minutes: 5

Throughput statistics on the APN for a duration of Sminutes.

Upstream Packets

Rate (per second) of upstream packets sent on this APN during the last sampling period.

Upstream Bits

Rate (per second) of upstream bits sent on this APN during the last sampling period.

Downstream Packets

Rate (per second) of downstream packets sent on this APN during the last sampling period.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Field

Description

Downstream Bits

Rate (per second) of downstream bits sent on this APN during the last sampling period.

Data Age (minutes)

The difference in minutes between the time when the data was collected and retrieved. This is the
time that has elapsed after the previous collection or update of the data.

APN Instance Bearer

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance Bearer statistics table, choose this option from the Type drop-down menu. The
GUI displays:

Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Active Bearers

Count—Total number of bearers on this APN.

Bearer Activations
Success

Count—Total number of successfully completed Bearer activation procedures by MS on this
APN.

Rate—Rate (per second) of successfully completed Bearer activation procedures by the MS
on this APN.

Ratio—Number of successful activations for every 100 activation attempts.

Bearer Activations
Failure

Count—Total number of failed Bearer activation procedures by the MS on this APN.

Rate—Rate (per second) of failed Bearer activation procedures by the MS on this APN.

Bearer Deactivations
Success

Count—Total number of successfully completed Bearer deactivation procedures by the SGW
on this APN.

Rate—Rate (per second) of successfully completed Bearer deactivation procedures by the
SGW on this APN.

Bearer Updates Success

Count—Total number of successful bearer update initiated by network.
Rate—Rate (per second) of successful bearer update initiated by network.

Ratio—Number of successful bearer update initiated by network for every 100 attempts.

Bearer Updates Failure

Count—Total number of unsuccessful bearer modify initiated by MME or SGSN.
Rate—Rate at which the unsuccessful bearer modify initiated by MME or SGSN.

Bearer Modifications
Success

Count—Total number of successful bearer modify initiated by MME or SGSN.
Rate—Rate (per second) of successful bearer modify initiated by MME or SGSN.

Ratio—Number of successful bearer modify initiated by MME or SGSN for every 100
initiation attempts.

Bearer Modifications
Failure

Count—Total number of unsuccessful bearer modify initiated by MME or SGSN.
Rate—Rate at which the unsuccessful bearer modify initiated by MME or SGSN.

[ oL-23900-01
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Field Description
Dedicated Bearer e Count—Total number of successful dedicated bearer creation initiated by network.

Activations Success .

Rate—Rate (per second) of successful dedicated bearer creation initiated by network.

Ratio—Number of successful dedicated bearer creation for every 100 bearer creation
attempts.

Dedicated Bearer .
Activations Failure

Count—Total number of unsuccessful dedicated bearer activation procedures received on this
APN.

Rate—Rate (per second) of unsuccessful dedicated bearer activation procedures received on
this APN.

EPC Buffering
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the EPC Buffering Statistics table, choose this option from the Type drop-down menu. The GUI
displays the following categories:

e Buffering Configuration, page 11-90

e Buffering Status, page 11-90

e Buffering Statistics, page 11-91

Buffering Configuration

The Buffering Configuration pane shows:

Field Description

Buffering Agent Status The state of buffering agent.

Maximum Buffer Size The maximum buffer size allocated for the buffering agent per bearer.
Buffer Duration The duration for which the buffering agent stores data before discarding it.
Maximum Packets Per The maximum number of packets allowed per buffer.

Buffer

Buffering Status

The Buffering Status pane shows:

Field Description

Total In Use Buffers Count— Total number of buffers currently in use.

Total Buffered Packets Count—Total number of packets buffered at present in the buffer.

Total Buffered Bits Count—Total number of bits buffered at present in the buffer.

Total Buffers Available Count—Current available buffer size.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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The Buffering Statistics pane shows:

Field

Description

Buffers Created

Count—Total number of buffers created.

Rate—Rate at which the buffers are created.

Buffers Deleted

Count—Total number of buffers deleted.

Rate—Rate at which the buffers are deleted.

Buffer Rejected Low
Memory

Count—Total number of times the buffer allocation is rejected due to low memory availability
in the gateway.

Rate—Rate at which the buffer allocation is rejected due to low memory availability in the
gateway.

Buffers Timed Out

Count—Total number of buffers that got timed out.

Rate—Rate at which the buffers got timed out.

Buffer Packets Enqueued

Count—Total number of packets enqueued to the buffering agent.

Rate—Rate at which the packets are enqueued to the buffering agent.

Buffer Rejected Memory
Unavailable

Count—Total number of times the buffer allocation is rejected by gateway due to requested
memory is greater than the total available buffers.

Rate—Rate at which the buffer allocation is rejected by gateway due to requested memory is
greater than the total available buffers.

Buffer Packets Dequeued

Count—Total number of packets dequeued from the buffering agent.

Rate—Rate at which the packets are dequeued from the buffering agent.

Buffer Bits Enqueued

Count—Total bits of data enqueued to the buffering agent.
Rate—Rate at which the bits of data are enqueued to the buffering agent.

Buffer Bits Dequeued

Count—Total bits of data dequeued from the buffering agent.
Rate—Rate at which the bits of data are dequeued from the buffering agent.

EPC Overload Protection

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the EPC Overload Protection Statistics table, choose this option from the Type drop-down menu.
The GUI displays the following categories:

e Status Information, page 11-92
e Congestion Threshold Information, page 11-92
e Statistics Information, page 11-92

e Congestion Times, page 11-92
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Status Information

The Status Information pane shows:

Field Description

Congestion Status The congestion gateway status.

Congestion DFP Weight |The dfp value, which is used to measure the congestion level in the gateway.

Congestion Threshold Information

The Congestion Threshold Information pane shows:

Field Description

Congestion Low The low threshold for congestion.
Threshold %

Congestion High The high threshold for congestion.
Threshold %

Statistics Information

The Statistics Information pane shows:

Field Description

Call Requests Dropped e Count—Total number of incoming calls dropped at the gateway.

e Rate—Rate at which the incoming calls are dropped at the gateway.

Times High Congestion ¢ Count—The number of times high congestion occurred on the gateway.
Reached e Rate—Rate at which the high congestion occurred on the gateway.
Times Low Congestion e Count—The number of times low congestion occurred on the gateway.
Reached

e Rate—Rate at which the low congestion are occurred on the gateway.

Congestion Times

The Congestion Times pane shows:

Field Description

Congestion Low ¢ Last Occurrence—Timestamp at which the low congestion last occurred on the gateway.

e Last Duration—Duration of last low congestion.

Congestion High e Last Occurrence—Timestamp at which the high congestion last occurred on the gateway.

e Last Duration—Duration of last high congestion.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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~

Note

Displaying SGW Real-Time Statistics

For toolbar details, see Using the Toolbar, page 11-6.

To view the GTP Statistics table, choose this option from the Type drop-down menu. The GUI displays

the following categories:

e GTP Active Statistics, page 11-93

e Charging Statistics, page 11-93

e GTP Bearer Statistics, page 11-94

e GTP Throughput Statistics, page 11-94

e GTP Throughput Statistics Ext, page 11-95

e GTP Error Statistics, page 11-96

GTP Active Statistics

The GTP Statistics pane shows:

Column Description
Bearers ¢ Count—Total number of bearers.
Users e Count—Total number of users.

Charging Statistics

The Charging Statistics pane shows:

Field Description
Current Open e Count—The number of currently opened G-CDRs on the SGW.
CDRs

Rate—Rate of currently opened G-CDRs on the SGW.

Current Closed
CDRs

Count—The number of currently closed G-CDRs on the SGW which have
not been sent to the CG.

Rate—Rate of currently closed G-CDRs on the SGW which have not been
sent to the CG.

Current Containers

Count—The number of currently open or closed charging containers.

Rate—Rate of currently open or closed charging containers.

CDR Messages e Count—The number of currently pending G-CDR output messages.
Pending e Rate—Rate of currently pending G-CDR output messages.

CDR Messages e Count—The number of transmitted G-CDR output messages since the
Sent charging service is enabled.

Rate—Rate of transmitted G-CDR output messages since the charging
service is enabled.
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Field Description
CDRs Opened ¢ Count—Total number of CDRs opened on the SGW either since system
startup or since the last time the charging statistics was cleared.
e Rate—Rate of CDRs opened on the SGW either since system startup or since
the last time the charging statistics was cleared.
Containers Created | ¢ Count—Total number of containers created on the SGW either since system
startup or since the last time the charging statistics was cleared.
e Rate—Rate of containers created on the SGW either since system startup or
since the last time the charging statistics was cleared.
Service Records ¢ Count—Total number of service records created on the SGW either since the
Created system startup or since the time the service aware feature is enabled.
e Rate—Rate of service records created on the SGW either since the system
startup or since the time the service aware feature is enabled.
Total Unique APNs | ¢ Count—The number of access points for which charging data is being
collected.
e Rate—Rate of access points for which charging data is being collected.
Charging Gateway | ® Count—The number of occurrences of cgprsCgAlarmEchoFailure traps state
Down Times transitions since system startup.
e Rate—Rate of occurrences of cgprsCgAlarmEchoFailure traps state
transitions since system startup.
GTP Bearer Statistics

The GTP PDP/Bearer Statistics pane shows:

Column

Description

Bearer Activation
Failure Ratio

Count—Ratio of bearer activation request to bearer activation failures.

Rate—Rate (per second) of ratio of bearer activation request to bearer
activation failures.

Bearers Created

Count—Number of bearers created since the system is up.

Rate—Rate at which the bearers are created since the system is up.

Bearers Rejected

Count—Number of bearers rejected since the system is up.

Rate—Rate at which the bearers are rejected since the system is up.

Bearers Deleted

Count—Number of bearers deleted since the system is up

Rate—Rate at which the bearers are deleted since the system is up.

GTP Throughput Statistics

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Column

Description

GTP signaling
Messages Sent

e Count—Number of signaling messages sent on a SGSN path.

e Rate—Rate at which the signaling messages are sent on a SGSN path.

GTP Signaling
Messages Received

e Count—Number of signaling messages received on a SGSN path.

e Rate—Rate at which the signaling messages are received on a SGSN path.

G-PDU Messages
Sent

¢ Count—Number of PDU messages sent on a SGSN path.
e Rate—Rate at which the PDU messages are sent on a SGSN path.

G-PDU Messages
Received

e Count—Number of PDU messages received on a SGSN path.
e Rate—Rate at which the PDU messages are received on a SGSN path.

G-PDU Bits Sent

¢ Count—Number of PDU bits sent in PDU message on a SGSN path.
e Rate—Rate at which the PDU bits are sent in PDU message on a SGSN path.

G-PDU Bits
Received

e Count—Number of PDU bits received in PDU message on a SGSN path.

e Rate—Rate at which the PDU bits are received in PDU message on a SGSN
path.

GTP Throughput Statistics Ext

The GTP Throughput Statistics Ext pane shows:

Field Description
GTP Packets GTP packets between the SGW and SGSN.
GTP Bytes GTP bytes between the SGW and SGSN.

Sampling Interval
in Minutes: 3

Global GTP throughput statistics on the SGW for a duration of 3 minutes.

Sampling Interval
in Minutes: 5

Global GTP throughput statistics on the SGW for a duration of 5 minutes.

Upstream

Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream

Rate (per second) of downstream GTP traffic during the last sampling period.

Data age (minutes)

The difference in minutes between the time when the data was collected and
retrieved. This is the time that has elapsed after the previous collection or update
of the data.
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GTP Error Statistics

The GTP Error Statistics pane shows:

Column Description

GTP Messages with | ® Count—Number of GTP messages received with wrong value.

Parser Errors e Rate—Rate (per second) of GTP messages received with wrong value.

Dropped Signaling | ¢ Count—Number of signaling packets dropped by SGW.

Messages e Rate—Rate at which the signaling packets are dropped by SGW.
Unexpected GTP ¢ Count—Number of unexpected GTP signaling messages received.
Signaling Messages

e Rate—Rate at which the unexpected GTP signaling messages are received.

GTPv2 Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Statistics table, choose this option from the Type drop-down menu. The GUI displays
the following categories:

e GTPv2 Bearer Statistics, page 11-96
e GTPv2 Session Statistics, page 11-97

GTPv2 Bearer Statistics

The GTPv2 Bearer Statistics pane shows:

Field Description

Delete Bearer Responses |Total number of delete bearer response messages.

Update Bearer Requests | Total number of update bearer request messages.

Modify Bearer Requests |Total number of modify bearer request messages.

Create Bearer Requests | Total number of create bearer request messages.

Sent ¢ Count—Total number of bearer response or bearer request messages sent.

e Rate—Rate at which the bearer response or bearer request messages are sent.

Received ¢ Count—Total number of bearer response or bearer request messages received.

e Rate—Rate at which the bearer response or bearer request messages are received.

Rejected e Count—Total number of bearer response or bearer request messages rejected.

e Rate—Rate at which the bearer response or bearer request messages are rejected.
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GTPv2 Session Statistics

The GTPv2 Session Statistics pane shows:

Field Description

Delete Session Responses |Total number of delete session response messages.

Create Session Responses |Total number of create session response messages.

Delete Session Requests | Total number of delete session request messages.

Create Session Requests |Total number of create session request messages.

Sent e Count—Total number of session response or session request messages sent.

e Rate—Rate at which the session response or session request messages are sent.

Received e Count—Total number of session response or session request messages received.

e Rate—Rate at which the session response or session request messages are received.

Rejected ¢ Count—Total number of session response or session request messages rejected.

e Rate—Rate at which the session response or session request messages are rejected.

GTPv2 Path Bearer Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Bearer Statistics table, choose this option from the Type drop-down menu. The
GUI displays:

Field Description
GTP Path GTP path.
Create Requests Sent e Count—Total number of create bearer request messages sent.

e Rate—Rate at which the create bearer request messages are sent.

Create Requests Received | © Count—Total number of create bearer request messages received.

e Rate—Rate at which the create bearer request messages are received.

Create Requests Rejected | ¢ Count—Total number of create bearer request messages rejected.

e Rate—Rate at which the create bearer request messages are rejected.

Modify Requests Sent e Count—Total number of modify bearer request messages sent.

e Rate—Rate at which the modify bearer request messages are sent.

Modify Requests ¢ Count—Total number of modify bearer request messages received.
e e Rate—Rate at which the modify bearer request messages are received.
Modify Requests e Count—Total number of modify bearer request messages rejected.
Rejected

e Rate—Rate at which the modify bearer request messages are rejected.
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Field

Description

Update Requests Sent

Count—Total number of update bearer request messages sent.

Rate—Rate at which the update bearer request messages are sent.

Update Requests
Received

Count—Total number of update bearer request messages received.

Rate—Rate at which the update bearer request messages are received.

Update Requests
Rejected

Count—Total number of update bearer request messages rejected

Rate—Rate at which the update bearer request messages are rejected.

Delete Responses Sent

Count—Total number of delete bearer response messages sent.

Rate—Rate at which the delete bearer response messages are sent.

Delete Responses
Received

Count—Total number of delete bearer response messages received

Rate—Rate at which the delete bearer response messages are received.

Delete Responses
Rejected

Count—Total number of delete bearer response messages rejected.

Rate—Rate at which the delete bearer response messages are rejected.

GTPv2 Path Session Statistics

~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Session Statistics table, choose this option from the Type drop-down menu. The
GUI displays:

Field

Description

GTP Path

GTP path.

Create Requests Sent

Count—Total number of create session request messages sent.

Rate—Rate at which the create session request messages are sent.

Create Requests Received

Count—Total number of create session request messages received.

Rate—Rate at which the create session request messages are received.

Create Requests Rejected

Count—Total number of create session request messages rejected.

Rate—Rate at which the create session request messages are rejected.

Delete Requests Sent

Count—Total number of delete session request messages sent.

Rate—Rate at which the delete session request messages are sent.

Delete Requests Received

Count—Total number of delete session request messages received.

Rate—Rate at which the delete session request messages are received.

Delete Requests Rejected

Count—Total number of delete session request messages rejected.

Rate—Rate at which the delete session request messages are rejected.

Create Responses Sent

Count—Total number of create session response messages sent.

Rate—Rate at which the create session response messages are sent.
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Field Description

Create Responses e Count—Total number of update session response messages received.
e e Rate—Rate at which the update session response messages are received.
Create Responses e Count—Total number of update session response messages rejected
Rejected e Rate—Rate at which the update session response messages are rejected.

Delete Responses Sent e Count—Total number of delete session response messages sent.

e Rate—Rate at which the delete session response messages are sent.

Delete Responses e Count—Total number of delete session response messages received
Received e Rate—Rate at which the delete session response messages are received.
Delete Responses ¢ Count—Total number of delete session response messages rejected.
Rejected e Rate—Rate at which the delete session response messages are rejected.

GTP Path Error Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTP Path Error Statistics table, choose this option from the Type drop-down menu. The GUI

displays:
Field Description
GTP Path GTP path.
Signaling Messages Unexpected

e Count—Number of unexpected GTP signaling messages sent or received.
e Rate—Rate at which the unexpected GTP signaling messages are sent or received.
Dropped

e Count—Number of signaling messages that are dropped.

e Rate—Rate at which the signaling messages are dropped.

IP Local Pool Configuration

The GUI displays the same fields as that of IP Local Pool Configuration statistics for GGSN node. See
IP Local Pool Config, page 11-79.

IP Local Pool Statistics

The GUI displays the same fields as that of IP Local Pool statistics for GGSN node. See IP Local Pool
Stats, page 11-80.
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Displaying PDNGW Real time statistics

The MWTM enables you to display real-time statistics for PDNGW nodes in the MWTM web interface.
To display real-time statistics, select the node in the navigation tree and click the Statistics tab. These

AAA

options appear under the Type drop down list:
e AAA, page 11-100
e APN Instance Throughput, page 11-100

e APN Instance Throughput Ext, page 11-100

e APN Instance PDP/Bearer, page 11-100

e APN Instance PDP/Bearer Ext, page 11-101
e APN Instance Miscellaneous, page 11-102

e EPC Buffering, page 11-103

e EPC Overload Protection, page 11-103
e GTP Statistics, page 11-103

e GTPv2 Statistics, page 11-107

e GTPv2 Path Bearer Statistics, page 11-107
e GTPv2 Path Session Statistics, page 11-108

e GTP Path Error Statistics, page 11-108

e [P Local Pool Configuration, page 11-108

e [P Local Pool Statistics, page 11-109

The GUI displays the same fields as that of AAA Statistics for SGW node. See AAA, page 11-86.

APN Instance Throughput

The GUI displays the same fields as that of APN Instance Throughput Statistics for SGW node. See APN

Instance Throughput, page 11-88.

APN Instance Throughput Ext

The GUI displays the same fields as that of APN Instance Throughput Ext Statistics for SGW node. See

APN Instance Throughput Ext, page 11-88.

APN Instance PDP/Bearer

S

Note

For toolbar details, see Using the Toolbar, page 11-6.

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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To view the APN Instance PDP/Bearer Statistics table, choose this option from the Type drop-down
menu. The GUI displays:

Field Description

APN Name The name of the Access Point Name (APN).

APN Index A unique numerical identifier for the APN.

Active PDP/Bearers e Count—Number of active PDP contexts or Bearers on this APN.

PDP/Bearer Activations ¢ Count—Total number of successfully completed PDP context/Bearer activation procedures
by MS Success by the MS on this APN.

e Rate—Rate (per second) of successfully completed PDP context/Bearer activation
procedures by the MS on this APN.

e Ratio—Number of successful activations for every 100 activation attempts.

PDP/Bearer Activations e Count—Total number of failed PDP context/Bearer activation procedures by the MS on this
by MS Failure APN.
e Rate—Rate (per second) of failed PDP context/Bearer activation procedures by the MS on
this APN.
PDP/Bearer ¢ Count—Total number of successfully completed PDP context/Bearer deactivation procedures
Deactivations by Network by the PDNGW on this APN.
Success e Rate—Rate (per second) of successfully completed PDP context/Bearer deactivation
procedures by the PDNGW on this APN.
PDP/Bearer ¢ Count—Total number of failed PDP context/Bearer deactivation procedures by the PDNGW
Deactivations by Network on this APN.
Failure

e Rate—Rate (per second) of failed PDP context/Bearer deactivation procedures by the
PDNGW on this APN.

PDP/Bearer Retainability | ¢ Ratio—For every 100 PDP contexts/Bearers, the number of activations whose deactivation
was not completed by the network.

PDP/Bearer e Count—Total number of successfully completed PDP context/Bearer deactivation procedures
Deactivations by MS by the MS on this APN.
Success

e Rate—Rate (per second) of successfully completed PDP context/Bearer deactivation
procedures by the MS on this APN.

e Ratio—Number of successful deactivations for every 100 deactivation attempts.

PDP/Bearer e Count—Total number of failed PDP context/Bearer deactivation procedures by the MS on this
Deactivations by MS APN.
Failure

e Rate—Rate (per second) of failed PDP context/Bearer deactivation procedures by the MS on
this APN.

APN Instance PDP/Bearer Ext
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the APN Instance PDP/Bearer Ext Statistics table, choose this option from the Type drop-down
menu. The GUI displays:
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Field Description
APN Name The name of the Access Point Name (APN).
APN Index A unique numerical identifier for the APN.

Dynamic PDP/Bearer
Activations By MS
Success

Count—Total number of successfully completed dynamic PDP context/Bearer activation
procedures by the MS on this APN.

Rate—Rate (per second) of successfully completed dynamic PDP context/Bearer activation
procedures by the MS on this APN.

Ratio—Number of successful dynamic activations for every 100 dynamic activation attempts.

Dynamic PDP/Bearer
Activations By MS
Failure

Count—Total number of failed dynamic PDP context/Bearer activation procedures by the MS on
this APN.

Rate—Rate (per second) of failed dynamic PDP context/Bearer activation procedures by the MS
on this APN.

PDP/Bearer Activations
By Network Success

Count—Total number of successfully completed network initiated PDP context/Bearer
activation procedures.

Rate—Rate (per second) successfully completed network initiated PDP context/Bearer
activation procedures.

Ratio—number of successful network initiated activations for every 100 activation attempts.

PDP/Bearer Activations
By Network Failure

Count—Total number of failed network initiated PDP context/Bearer activation procedures.

Rate—Rate (per second) failed network initiated PDP context/Bearer activation procedures.

PDP/Bearer Updates By
Network Success

Count—Total number of successful update responses received on this APN.
Rate—Rate (per second) of successful update responses received on this APN.

Ratio—Number of successful update responses received for every 100 activation attempts.

PDP/Bearer Updates By
Network Failure

Count—Total number of unsuccessful update responses received on this APN.

Rate—Rate (per second) of unsuccessful update responses received on this APN.

Dedicated Bearer
Activations Success

Count—Total number of successful dedicated bearer activation procedures received on this
APN.

Rate—Rate (per second) of successful dedicated bearer activation procedures received on this
APN.

Ratio—Number of successful dedicated bearer activation procedures for every 100 activation
attempts.

Dedicated Bearer
Activations Failure

Count—Total number of unsuccessful dedicated bearer activation procedures received on this
APN.

Rate—Rate (per second) of unsuccessful dedicated bearer activation procedures received on
this APN.

APN Instance Miscellaneous

The GUI displays the same fields as that of APN instance Miscellaneous Statistics for GGSN node. See

APN Instance Miscellaneous, page 11-78.
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The GUI displays the same fields as that of EPC Buffering Statistics for SGW node. See EPC Buffering,

page 11-90.

EPC Overload Protection

The GUI displays the same fields as that of EPC Overload protection Statistics for SGW node. See EPC
Overload Protection, page 11-91.

GTP Statistics

~

For toolbar details, see Using the Toolbar, page 11-6.

To view the GTP Statistics table, choose this option from the Type drop-down menu. The GUI displays

e GTP Active Statistics, page 11-103

e GTP PDP/Bearer Statistics, page 11-104

e GTP Throughput Statistics, page 11-105

e GTP Throughput Statistics Ext, page 11-95

Note
the following categories:
e Charging Statistics, page 11-104
e GTP Error Statistics, page 11-106
GTP Active Statistics

The GTP Active Statistics pane shows:

Column Description

GTP vO PDP PDP contexts (GTP version 0) that are active.

Contexts

GTP vl PDP PDP contexts (GTP version 1) that are active.

Contexts

GTP v2 EPS EPS bearers (GTP version 2) that are active.

Bearers

PPP Regen PDPs Device-specific interfaces created for association with PDP contexts regenerated
to a Point-to-Point (PPP) session.

PPP PDPs Total number of point to point PDP contexts.

PDP Contexts with
Direct Tunnel

Direct tunnels enabled for the PDP contexts in the PDNGW.
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Charging Statistics

The Charging Statistics pane shows:

Field Description
Current Open e Count—The number of currently opened G-CDRs on the PDNGW.
CDRs

Rate—Rate of currently opened G-CDRs on the PDNGW.

Current Closed
CDRs

Count—The number of currently closed G-CDRs on the PDNGW which
have not been sent to the CG.

Rate—Rate of currently closed G-CDRs on the PDNGW which have not
been sent to the CG.

Current Containers

Count—The number of currently open or closed charging containers.

Rate—Rate of currently open or closed charging containers.

CDR Messages e Count—The number of currently pending G-CDR output messages.
Pending e Rate—Rate of currently pending G-CDR output messages.

CDR Messages ¢ Count—The number of transmitted G-CDR output messages since the
Sent charging service is enabled.

Rate—Rate of transmitted G-CDR output messages since the charging
service is enabled.

CDRs Opened

Count—Total number of CDRs opened on the PDNGW either since system
startup or since the last time the charging statistics was cleared.

Rate—Rate of CDRs opened on the PDNGW either since system startup or
since the last time the charging statistics was cleared.

Containers Created

Count—Total number of containers created on the PDNGW either since
system startup or since the last time the charging statistics was cleared.

Rate—Rate of containers created on the PDNGW either since system startup
or since the last time the charging statistics was cleared.

Service Records
Created

Count—Total number of service records created on the PDNGW either since
the system startup or since the time the service aware feature is enabled.

Rate—Rate of service records created on the PDNGW either since the
system startup or since the time the service aware feature is enabled.

Total Unique APNs

Count—The number of access points for which charging data is being
collected.

Rate—Rate of access points for which charging data is being collected.

Charging Gateway
Down Times

Count—The number of occurrences of cgprsCgAlarmEchoFailure traps state
transitions since system startup.

Rate—Rate of occurrences of cgprsCgAlarmEchoFailure traps state
transitions since system startup.

GTP PDP/Bearer Statistics
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Column

Description

PDP/Bearer
Context Activation
Failure Ratio

Count—Ratio of PDP/bearer activation request to bearer activation failures.

Rate—Rate (per second) of ratio of PDP/bearer activation request to bearer
activation failures.

PDP/Bearer
Contexts Created

Count—Number of PDP/bearers created since the system is up.

Rate—Rate at which the PDP/bearers are created since the system is up.

PDP/Bearer ¢ Count—Number of PDP/bearer activation requests rejected since the system
Context Activations is up.
Rejected e R . S . .
ate—Rate at which the PDP/bearer activation requests are rejected since
the system is up.
PDP/Bearer e Count—Number of PDP/bearers deleted since the system is up

Contexts Deleted

Rate—Rate at which the PDP/bearers are deleted since the system is up.

GTP Throughput Statistics

The GTP Throughput Statistics pane displays count and rate statistics about GTP throughput and shows:

Column

Description

GTP Signaling
Messages Sent

Count—Number of signaling messages sent on a SGSN path.

Rate—Rate at which the signaling messages are sent on a SGSN path.

GTP Signaling
Messages Received

Count—Number of signaling messages received on a SGSN path.

Rate—Rate at which the signaling messages are received on a SGSN path.

G-PDU Messages
Sent

Count—Number of PDU messages sent on a SGSN path.
Rate—Rate at which the PDU messages are sent on a SGSN path.

G-PDU Messages
Received

Count—Number of PDU messages received on a SGSN path.
Rate—Rate at which the PDU messages are received on a SGSN path.

G-PDU Bits Sent

Count—Number of PDU bits sent in PDU message on a SGSN path.
Rate—Rate at which the PDU bits are sent in PDU message on a SGSN path.

G-PDU Bits
Received

Count—Number of PDU bits received in PDU message on a SGSN path.

Rate—Rate at which the PDU bits are received in PDU message on a SGSN
path.

GTP Throughput Statistics Ext

The GTP Throughput Statistics Ext pane shows:

Field Description
GTP Packets GTP packets between the PDNGW and SGSN.
GTP Bytes GTP bytes between the PDNGW and SGSN.
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User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5 g



Chapter 11 Accessing Data from the Web Interface

| Displaying PDNGW Real time statistics

GTP Error Statistics

Field

Description

Sampling Interval
in Minutes: 3

Global GTP throughput statistics on the PDNGW for a duration of 3 minutes.

Sampling Interval
in Minutes: 5

Global GTP throughput statistics on the PDNGW for a duration of 5 minutes.

Upstream

Rate (per second) of upstream GTP traffic during the last sampling period.

Downstream

Rate (per second) of downstream GTP traffic during the last sampling period.

Data age (minutes)

The difference in minutes between the time when the data was collected and
retrieved. This is the time that has elapsed after the previous collection or update
of the data.

The GTP Error Statistics pane shows:

Column Description

PDP Context e Count—Number of PDP context requests rejected due to insufficient resources.
Ac.tlvatlons e Rate—Rate at which the PDP context requests are rejected due to insufficient resources.
Rejected due to

Insufficient

Resources

PDP Context
Requests Rejected
due to Insufficient
Resources
Rejection for PPP
Regeneration

Count—Number of PDP context requests rejected due to insufficient resources for PPP
regeneration.

Rate—Rate at which the PDP context requests are rejected due to insufficient resources for PPP
regeneration.

PDP Context
Requests Dropped
due to the PPP
Regeneration
Threshold Limit

Count—Number of PDP context requests dropped due to the PPP regeneration threshold limit.

Rate—Rate at which the PDP context requests are dropped due to the PPP regeneration threshold
limit.

PDP Context
Messages with
Packet Filter
Semantic Errors

Count—Total number of received PDP context messages that had packet filters with semantic errors.

Rate—Rate at which the PDP context messages that had packet filters with semantic errors are received.

PDP Context
Messages with
Packet Filter
Syntax Errors

Count—Total number of received PDP context messages that had packet filters with syntax errors.

Rate—Rate at which the PDP context messages that had packet filters with syntax errors are received.

PDP Context
Messages with TFT
Syntax Errors

Count—Total number of received PDP context messages that had Traffic Flow Templates (TFT) with
syntax errors.

Rate—Rate at which the PDP context messages that had Traffic Flow Templates (TFT) with syntax
errors are received.

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Column Description
PDP Context e Count—Total number of received PDP context messages that had Traffic Flow Templates (TFT) with
Messages with TFT semantic errors.

Semantic Errors

e Rate—Rate at which the PDP context messages that had Traffic Flow Templates (TFT) with semantic
errors are received.

Unexpected GTP e Count—Number of unexpected GTP signaling messages sent or received.
Signaling Messages | Rate—Rate at which the unexpected GTP signaling messages are sent or received.
Dropped GTP e Count—Number of dropped GTP signaling messages.

Signaling Messages | Rate—Rate at which the GTP signaling messages are dropped.

GTP Message e Count—Number of GTP messages received with wrong value.

Parsers Errors

e Rate—Rate at which the GTP messages with wrong value are received.

GTPv2 Statistics

The GUI displays the same fields as that of GTPv2 Statistics for SGW node. See GTPv2 Statistics,
page 11-96.

GTPv2 Path Bearer Statistics

~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Bearer Statistics table, choose this option from the Type drop-down menu. The
GUI displays:

Field

Description

GTP Path

GTP path.

Create Requests Received

Count—Total number of create bearer request messages received.

Rate—Rate at which the create bearer request messages are received.

Create Requests Rejected

Count—Total number of create bearer request messages rejected.

Rate—Rate at which the create bearer request messages are rejected.

Modify Requests
Received

Count—Total number of modify bearer request messages received.

Rate—Rate at which the modify bearer request messages are received.

Modify Requests
Rejected

Count—Total number of modify bearer request messages rejected.

Rate—Rate at which the modify bearer request messages are rejected.

Update Requests
Received

Count—Total number of update bearer request messages received.

Rate—Rate at which the update bearer request messages are received.

[ oL-23900-01
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Field Description
Update Requests ¢ Count—Total number of update bearer request messages rejected.
Rejected e Rate—Rate at which the update bearer request messages are rejected.

Delete Responses Sent e Count—Total number of delete bearer response messages sent.

e Rate—Rate at which the delete bearer response messages are sent.

GTPv2 Path Session Statistics
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the GTPv2 Path Session Statistics table, choose this option from the Type drop-down menu. The

GUI displays:
Field Description
GTP Path GTP path.

Create Requests Received | ¢ Count—Total number of create session request messages received.

e Rate—Rate at which the create session request messages are received.

Create Requests Rejected | ¢ Count—Total number of create session request messages rejected.

e Rate—Rate at which the create session request messages are rejected.

Delete Requests Received | ¢ Count—Total number of delete session request messages received.

e Rate—Rate at which the delete session request messages are received.

Delete Requests Rejected | ¢ Count—Total number of delete session request messages rejected.

e Rate—Rate at which the delete session request messages are rejected.

Create Responses Sent ¢ Count—Total number of create session response messages sent.

e Rate—Rate at which the create session response messages are sent.

Delete Responses Sent e Count—Total number of delete session response messages sent.

e Rate—Rate at which the delete session response messages are sent.

GTP Path Error Statistics

The GUI displays the same fields as that of GTP Path Error Statistics for SGW node. See GTP Path Error
Statistics, page 11-99.

IP Local Pool Configuration

The GUI displays the same fields as that of IP Local Pool Configuration statistics for GGSN node. See
IP Local Pool Config, page 11-79.
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IP Local Pool Statistics

Displaying

Config

Note

Class Map

S

Note

The GUI displays the same fields as that of IP Local Pool statistics for GGSN node. See IP Local Pool
Stats, page 11-80.

QoS Statistics

You can view QOS real-time statistics for IP-RAN aggregation and cell-site routers that have both
pseudo wires and RAN Optimized backhauls. To view QOS real-time statistics for one of these nodes,
select the node in the navigation tree, then click the QoS tab.

The following options appear under View drop-down menu:
e Config, page 11-109
e (Class Map, page 11-109
¢ Queuing, page 11-110
e Match Statement, page 11-110
e Packet Marking, page 11-111
e Traffic Shaping, page 11-112
e Policing, page 11-112

For toolbar details, see Using the Toolbar, page 11-6.

To view the Config details, choose Config option from the View drop-down menu. The GUI displays a
bullet list/tree of the QOS configuration.

For toolbar details, see Using the Toolbar, page 11-6.

To view the Class Map Statistics table, choose Class Map option from the View drop-down menu. The
GUI displays:

Column Description

Class Map User-defined traffic class that contains one or many match statements used to
classify packets into different categories.

Service Policy The direction of traffic for which the service policy is applied.

Direction

Pre-Policy Packets |The number of inbound packets prior to executing any QoS policies.

[ oL-23900-01
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Column Description
Pre-Policy Bits The number of inbound octets prior to executing any QoS policies.
Pre-Policy Bits The rate of the traffic prior to executing any QoS policies.
Rate
Post-Policy Bits The number of outbound octets after executing QoS policies.
Post-Policy Bits The rate of the traffic after executing QoS policies
Rate
Dropped Packets The number of dropped packets per class as the result of all features that can
produce drops.
Dropped Bits The number of dropped bits per class as the result of all features that can produce
drops.
Drop Bits Rate The rate of the drops per class as the result of all features that can produce drops.
SRAM Buffer The number of drop packet count which occurred due to a lack of SRAM buffers
Dropped Packets during output processing on an interface.
Queuing

For toolbar details, see Using the Toolbar, page 11-6.

To view the Queuing Statistics table, choose Queuing option from the View drop-down menu. The GUI

displays:
Column Description
Class Map User-defined traffic class that contains one or many match statements used to

classify packets into different categories.

Service Policy
Direction

The direction of traffic for which the service policy is applied.

Queue Depth

The current depth of the queue.

Max Queue Depth

The maximum depth of the queue.

Queue Discarded
Bits

The count of octets, associated with this class, that were dropped by queueing.

Queue Discarded
Packets

The number of packets, associated with this class, that were dropped by
queueing.

Match Statement

~

Note

For toolbar details, see Using the Toolbar, page 11-6.
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To view the Match Statement Statistics table, choose Match Statement option from the View drop-down
menu. The GUI displays:

Column

Description

Class Map

User-defined traffic class that contains one or many match statements used to
classify packets into different categories.

Service Policy
Direction

The direction of traffic for which the service policy is applied.

Match Statement

The specific match criteria to identify packets for classification purposes.

Pre-Policy Packets

The number of inbound packets prior to executing any QoS policies.

Pre-Policy Bits

The number of inbound octets prior to executing any QoS policies.

Pre-Policy Bits
Rate

The rate of the traffic prior to executing any QoS policies.

Packet Marking

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the Packet Marking Statistics table, choose Packet Marking option from the View drop-down
menu. The GUI displays:

Column

Description

Class Map

User-defined traffic class that contains one or many match statements used to
classify packets into different categories.

Service Policy
Direction

The direction of traffic for which the service policy is applied.

DSCP Packets

The number of packets whose DSCP field is marked by Set feature.

Precedence Packets

The number of packets whose Precedence field is marked by Set feature.

QOS Group Packets

The number of packets whose Qos Group field is marked by Set feature.

Frame Relay DE
Packets

The number of packets whose Frame Relay DE Bit is marked by Set feature.

ATM CLP Packets

The number of packets whose ATM CLP Bit is marked by Set feature.

Layer 2 COS The number of packets whose Layer 2 Cos field is marked by Set feature.
Packets

MPLS The number of packets whose MPLS Experimental Imposition field is marked by
Experimental Set feature.

Imposition Packets

Discard Class
Packets

The number of packets whose Discard Class field is marked by Set feature.

MPLS
Experimental Top
Most Packets

The number of packets whose MPLS Experimental Top Most field is marked by
Set feature.
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Column

Description

SRP Priority
Packets

The number of packets whose SRP Priority field is marked by Set feature.

DSCP Tunnel
Packets

The number of packets whose DSCP Tunnel field is marked by Set feature.

Precedence Tunnel
Packets

The number of packets whose Precedence Tunnel field is marked by Set feature.

Frame Relay FECN

The number of packets whose Frame Relay FECN BECN field is marked by Set
feature.

Traffic Shaping
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the Traffic Shaping Statistics table, choose this option from the View drop-down menu. The GUI

displays:

Column

Description

Class Map

User-defined traffic class that contains one or many match statements used to
classify packets into different categories.

Service Policy
Direction

The direction of traffic for which the service policy is applied.

Active

The current traffic-shaping state. When traffic-shaping is enabled and the traffic
rate exceeds the shape rate, traffic-shaping is considered to be active. Otherwise,
it is considered inactive.

Queue Size

The current traffic-shaping queue depth in packets.

Delayed Bits

The number of octets that have been delayed.

Delayed Packets

The number of packets that have been delayed.

Dropped Bits

The number of octets that have been dropped during shaping.

Dropped Packets

The number of packets that have been dropped during shaping.

Policing
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5



| Chapter 11

Accessing Data from the Web Interface

Displaying

Displaying PWE3 Real-Time Statistics ||

To view the Policing Statistics table, choose Policing option from the View drop-down menu. The GUI

displays:
Column Description
Class Map User-defined traffic class that contains one or many match statements used to

classify packets into different categories.

Service Policy
Direction

The direction of traffic for which the service policy is applied.

Conformed Packets

The number of packets treated as conforming by the policing feature

Conformed Bits

The number of octets treated as conforming by the policing feature

Conformed Bits
Rate

The rate of conforming traffic.

Exceeded Packets

The number of packets treated as non-conforming by the policing feature.

Exceeded Bits

The number of octets treated as non-conforming by the policing feature.

Exceeded Bits Rate

The rate of non-conforming traffic.

Violated Packets

The number of packets treated as violated by the policing feature.

Violated Bits

The number of octets treated as violated by the policing feature.

Violated Bits Rate

The rate of the violating traffic.

PWE3 Real-Time Statistics

The MWTM enables you to display PWE3 real-time statistics in the MWTM web interface. Because the
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar,
the PWE3 real-time statistics are described in Viewing PWE3 Statistics, page 7-119.

Displaying TDM Real-Time Statistics

The MWTM enables you to display TDM real-time statistics in the MWTM web interface. Because the
MWTM client also displays these statistics and the GUIs for the web and client interfaces are so similar,
the TDM real-time statistics are described in Viewing TDM Statistics, page 7-105.

Displaying SLB Real time statistics

The MWTM enables you to display SLB real-time statistics in the MWTM web interface, for the mSEF
devices that support 7600 supervisor card. To display SLB real-time statistics, select the mSEF node that
supports 7600 supervisor card in the navigation tree and click the Statistics tab. These options appear
under the Type drop-down menu:

e Virtual Servers, page 11-114

e Real Servers, page 11-114

e Server Farms, page 11-115

¢ Global Statistics, page 11-116
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e DFP Agents, page 11-117
e DFP Real Servers, page 11-117

Virtual Servers

~

Note

Real Servers
~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the Virtual Server statistics table, choose Virtual Servers option from the Type drop-down menu.

The GUI displays:

Column

Description

Virtual Server
Name

Name of the virtual server.

Protocol Protocol for the virtual server.

IP Address IP address of the virtual server.

Port Port of the virtual server.

State State of the virtual server.

Current Number of currently assigned connections being handled by this virtual server.
Connections

Total Connections

e Count—Number of assigned connections handled by the virtual server since
the server was configured.

e Rate—Rate at which the assigned connections are handled by the virtual
server since the server was configured.

Server Farm

Name of the virtual server farm bound to the virtual server.

For toolbar details, see Using the Toolbar, page 11-6.

To view the Real server configuration and statistics table, choose Real Servers option from the Type
drop-down menu. The GUI displays:

Column Description

IP Address IP Address of the real server.

Farm Name Name of the server farm of the real server.

State Current state of real server.

Current Number of assigned connections being handled by this real server.
Connections

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5
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Column

Description

Total Connections

e Count—Number of assigned connections handled by this real server since
this server was configured.

e Rate—Rate at which the assigned connections are handled by the real server
since the server was configured.

Consecutive
Connection
Failures

Number of connection failures to this real server without a successful
connection.

Total Connection
Failures

e Count—Total number of times this real server has failed since the creation
of this row.

e Rate—Rate at which the real server has failed since the creation of this row.

Administrative
Weight

User-configured weight of the real server for the load balancing algorithms.

Operational Weight

Actual operating weight of the real server used by the load-balancing algorithms.

For toolbar details, see Using the Toolbar, page 11-6.

To view the Server farm configuration and statistics table, choose Server Farm option from the Type
drop-down menu. The GUI displays:

Column

Description

Farm Name

Name of the server farm.

Predictor

Load balancing algorithm in use by the server farm for its real servers for the
local SLB entity.

NAT Setting

Type of NAT employed by the local SLB entity for servers in this server farm.

Number of Real Number of real servers in the server farm.
Servers
Bind ID Identifies one or more server farms to which the real server belongs.
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Global Statistics

~

Note

For toolbar details, see Using the Toolbar, page 11-6.

To view the Global Statistics table, choose this option from the Type drop-down menu. The GUI

displays:

Field

Description

Assisted Switching
Packets

Count—Number of packets handled by SLB which are switched via the
highest-performance switching path.

Rate—Rate at which the packets are handled by SLB which are switched via
the highest-performance switching path.

Zombies ¢ Count—Number of TCP and UDP connections currently in the zombie state
waiting for timers to expire.
e Rate—Rate at which the TCP and UDP connections currently in the zombie
state waiting for timers are expired.
Connections e Count—Number of TCP and UDP connections reassigned from one real
Reassigned server to another.
e Rate—Rate at which the TCP and UDP connections are reassigned from one
real server to another.
Connections ¢ Count—Number of TCP and UDP connections destroyed by SLB, either by
Destroyed TCPIP teardown or timeout.
e Rate—Rate at which the TCP and UDP connections are destroyed by SLB.
Connections e Count—Number of TCP and UDP connections created since SLB was
Created configured.
e Rate—Rate at which the TCP and UDP connections are created since SLB is
configured.
Unassisted e Count—Number of packets forwarded by the Software Load Balancing

Switching Packets

manager's software.

Rate—Rate at which the packets are forwarded by the Software Load
Balancing manager's software.

Connections
Established

Count—Number of connections established through SLB.

Rate—Rate at which the connections are established through SLB.

[l User Guide for the Cisco Mobile Wireless Transport Manager 6.1.5

0L-23900-01



| Chapter11  Accessing Data from the Web Interface

Displaying SLB Real time statistics ||

DFP Agents
N

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the DFP Agents statistics table, choose this option from the Type drop-down menu. The GUI

displays:

Column Description

IP Address IP address of the DFP agent.

Port Port number of DFP agent.

State State of DFP agent.

Time Out Time interval during which the agent must send at least one message to the
manager.

Retry Count Number of times the manager will attempt to re-establish a connection with the
agent.

Agent Interval Time interval before SLB retries connecting to a DFP agent.

DFP Real Servers
~

Note  For toolbar details, see Using the Toolbar, page 11-6.

To view the DFP Real Servers statistics table, choose this option from the Type drop-down menu. The

GUI displays:

Column Description

IP Address IP address of the DFP agent.

Protocol Protocol of the real server.

Port Port number of real server.

Bind ID Identifies one or more server farms to which the real server belongs.
Real Weight Weight of the real server reported from a DFP agent.
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